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1. What’s 

1.1. Generalities 
Illuminando is a Cocoa Mac OS application specialized to perform lighting calculations. 

Illuminando works in metric or imperial units, runs on Apple computers running Mac OS, fully respecting 
the specific technology and implements OpenGL for rendering also with textures. 

The simplicity of use and the interface modeler should not be fooled; Illuminando is a 'easy to use' CAD 
that uses some tools in order to obtain a simple and effective input to create the scene and perform 
subsequent calculations. Applying the "sources", the set will be complete, let's start calculations and wait 
for the results. Verifications may proceeds both visually (on the virtual space generated by the 
Application) and technically (through plan projections, iso-vales curves, color-scale map,...). 

Illuminando has some implementable internal databases containing: 

• geographic/territorial information of some cities; 
• lighting sources catalogues and linked multi-currency prices files; 
• electrical wires catalogue and linked multi-currency prices files; 
• special pieces catalogue and linked multi-currency prices files; 

Iluminando can generate morphologically defined parametric objects (vaults, quadric surfaces, domes, 
etc..) or more complex through the use of primitives (cubes, spheres, cones, etc..) in order to simplify the 
design procedures or can import from DXF 3D or PDF 2D files. 

The working window projects objects within a three-dimensional space that displays the axial reference 
system and a plane of virtual modeling. The rationalization and intuitiveness of the available commands 
allow the acquisition of the graphics tools provided by the Application, minimizing the learning curve. 
Moreover, UNDO and REDO command allow the possibility of control in security in the working progress. 

Powerful LAYER and VIEW management, intelligent PASTING options (the Application allows to copy the 
attributes of an object and paste only those that is possible to transfer on an object with different 
characteristics), RESHAPE, MOVE, ROTATE, MIRROR, SCALE, OFFSET, rectangular and polar ARRAY, 
EXPLODE, JOIN, DIVIDE, EXTRUDE commands, online HELP for the execution of commands: these are 
some of the possibilities offered by Illuminando. 

The light sources, calculated as volumetric sources, are managed entirely by the Application, which allows 
you to import, display, edit and format IESNA LM-63 (ASCII text files normally used by manufacturers of 
lighting fixtures-North Americans), EULUMDAT (formed by European standards) and even drawings PDF 
or DXF (the Application converts drawings into photometry!) data files; photometric solids are summarized 
in 36 azimuthal C-curves and 180 zenithal gamma-angles, while the color of the lamps is given by the 
color temperature or real color. 

Illuminando is the only software that is able to handle linear sources (ex. strip led) called 'polyline-source' 
that can be segment by segment oriented. 

Illuminando can export to RTF a complete list, formatted according to user needs, of the installed products 
and special items, full of economic computing and electrical power. 

Illuminando provides users with powerful tools for design optimization: a window of pre-project for 
rectangular rooms, L or cutted-corner, with the CIE method, the correct number of sources to achieve a 
certain value of illuminance on the working surface. 

Illuminando has an utility for the road projects and road optimization: given the width of the street, 
through the choice of a variety of sources, distance and height of the poles, brackets, inclination, ..., the 
application builds a database for each configuration with all the performed simulations. Through the use 
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of filters you can choose from all the simulations carried out those that meet the parameters of law, the 
minimum installed capacity per kilometer, the configuration with maximum average luminance, .... 

Illuminando has a utility for the area projects: given the rectangular dimension of the area and the layout 
of the illumination plant the application builds the model to light. 

Illuminando has a tool to view spectral bulb data saved in XML format (according to IES TM-27-14 IES 
Standard Format for the Electronic Transfer of Spectral Data) or CSV format and to compare the color of 
two sources calculating their 'distance'. 

Illuminando has a tool to evaluate the maintenance factor of led fixtures. 

1.2. The Method 
After creating or importing the scene, the method used for calculations is the radiance one. 

The objects of the scene to calculate are divided into finite elements, which assess the amount of direct 
illumination due to natural sources (sun and sky) and/or artificial. The method involves the calculation of 
multiple reflections (for the interior) until the complete redistribution of the illuminance (unless the user do 
not stop the calculation). In the event that the calculation has been interrupted, the user can resume from 
where it was suspended to take it to completion. 

The information available when calculation is done is both visual (screen image) and numerical for the 
required verifications. The final real view is built in real colors or in color-scale. 

1.3. Video output 
The individual surfaces of the object subjected to calculation are editable and can be projected on a 
plane and presented with the actual colors on both faces. Furthermore, the entire scene appears on the 
screen and can be modified in real time, because the Application keeps all lighting information previously 
calculated. 

This means that the calculation time is long, but still proportional to the complexity of the scene and the 
number of the arranged light sources but, by counterpart, once completed, allow a total control of the 
scene, in real time and from whatever point of view we choose. 

Illuminando has also a tool section, which shifts the normal plane of the lens (the plane of the screen) 
forward or backward from the observer cutting, always in real time, the scene to verify the illuminament 
of interior spaces that are not visible. 

1.4. Numerical output 
The outputs of numerical type can be plotted on the surfaces projected on the plane and shown in iso-
value curves: 

• Illuminament horizontal, vertical X+, Y+, X-, Y-, semi-cylindrical , hemispherical and in camera 
direction; 

• Luminance; 
• Daylight coefficient, Useful Daylight Illuminance, Shadow factor; 
• Lighting pollution; 
• RGB; 
• Contrast Rendering Factor (C.R.F.); 
• Glare indexes (TI, G, U.G.R., C.G.I. and G.R.); 

The displayed curves can be represented in color overlaying the view, print directly, pasted to the 
clipboard or saved in one of the allowed export formats (DXF, PDF, JPG). 
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1.5. What's the use 
It is clear that, after this introduction, the use of Illuminando is wide but targeted on well defined 
problems. Illuminando is a flexible, fast and simple tool to address and solve problems related to various 
professional activities as well as to different purposes of practical application. 

It is also a powerful and intuitive verification tool to assess the compliance of systems to specific laws. 
Finally, it allows the economic computation of the entire plan, including lighting fixtures, electrical wiring 
and special pieces selected from a user-implementable database in more currencies. 

Illuminando is, therefore, the ideal tool for: 

• dimensioning and color-choice for the lighting sources; 
• exterior - road, tunnel, urban landscapes, stadium, monuments, etc.; 
• interior - showroom, auditorium, showcases, etc.; 
• optimization and choice of glazed surfaces; 
• choice of the plaster based of the real color lighting effect; 
• study of the shadows, owned and brought; 
• calculate the real lighting pollution in presence of obstructions; 
• checks and controls for television and glare. 

1.6. Who needs it 
Illuminando is a Macintosh Application dedicated to professionals working in the industry, architects, 
engineers, designers, builders, and their professional needs. To large industries that design lighting, 
institutions that determine the sites of application, the engineers charged in audits of facilities and 
verification of compliance of plant. 
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2. Getting started 
At the beginning Illuminando asks for selecting or creating some folders in which the application will save 
all the libraries and support files for exported reports: 

 
If an empty folder was selected/created as library folder Illuminando asks if the user wants to fill it with 
the default content: 

  

Then the installation procedure for the libraries folder will end: 

 
Finally Illuminando presents the window that permits to start working (see paragraph 3 Workspace). 
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3. Workspace 
At the beginning, the Application shows the scene in 3D mode view. Following default settings, may be 
visible: 

 
• Global Coordinate System with the axis X-Y-Z in green color (always visible); 
• Active Coordinate System with the axis x-y-z in red color; 
• The graphic grid of the Active Coordinate System at z=0; 

3.1. Document Window 
For each Document the main window contains the model and some instruments depending on the type of 
visualization, but for each mode it is possible: 

• reposition the window with the title bar; 
• redimension the window from the edges and with zoom (green) and collapse (yellow) button in 

the title bar; 
• close the window whit the close (red) button in the title bar. 

Visualization mode may be: 

1. 3D view 
2. Plan view 
3. Result view 
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3.1.1. 3D View mode 

This is the mode in which the software presents a new document and the only one in which is possible to 
create and edit all drawing elements. 

The drawer contains three groups of buttons, a coordinate section and a result visualization section: 

The Tool group contains: 

Surface dialog Surface input 

 

Free surface input Wall input 

Opening dialog Opening with glass 
input 

Opening opaque 
input 

Opening empty 
input 

Line dialog Line input Quote input Wire input 

Polyline dialog Polyline input Arc, polygon input Poly-wire input 

Source dialog Source input Object dialog Object input 

Camera dialog Camera input Text input - 

The View group contains 

Setting dialog Escape (ESC) 
command 

 

Models link 
ON/OFF 

Center view 

Grid ON/OFF Snap to grid 
ON/OFF 

Snap to points 
ON/OFF 

Zoom window 

Zoom out Zoom in Rotate X clockwise Rotate X 
counterclockwise 

Front cut plane 
forward 

Front cut plane back Rotate Y clockwise Rotate Y 
counterclockwise 

Camera out Camera in Rotate Z clockwise Rotate Z 
counterclockwise 

View modifications may be done also with the mouse wheel: 

1. top, bottom, left and right view movements permits to scroll the 3D view; 
2. pressing the ⌥(option) key at the horizontal mouse-wheel moving the software will react with an 

horizontal view rotation (pitch), and to a vertical mouse-wheel moving a vertical view rotation 
(yaw) will be linked. 

3. pressing the ⌘(command) key the mouse-wheel moving will be linked to a video-plan view 
rotation (roll); 

4. pressing the ⇧(shift) key vertical mouse-wheel movements will be linked to the zoom (Zoom in and 
out), while horizontal mouse-wheel movement will be linked to the eye position (Camera in and 
out). 

The Coordinate section contains: 

• editable field X: reports the current X coordinate of the mouse on the Active Coordinate System in 
the current units (cm or in); 

• lock X-coordinate button (key 'x'); 
• editable field Y: reports the current Y coordinate of the mouse on the Active Coordinate System in 

the current units (cm or in); 
• lock Y-coordinate button (key 'y'); 
• editable field Z: reports the current Z coordinate of the mouse on the Active Coordinate System in 

the current units (cm or in); 
• lock Z-coordinate button (key 'z'); 
• editable field Az: reports the angle in the XY plan in degrees between the traced segment and the 

Active Coordinate System X axis (azimuth angle); 
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• lock Azimuth angle button (key 'a'); 
• field zN: Reports the angle from the XY plan in degrees between the traced segment and the 

Active Coordinate System X axis (zenith angle) 
• lock Zenith angle button (key 'n'); 
• editable field Distance: reports the length in the current units (cm or in) of the segment traced from 

the last point; 
• lock Distance button (key 'd'); 

With these edit fields and lockers it is possible to introduce the points with the keyboard (the Z coordinate, 
if not belong to the design plan, always has to be introduced with the keyboard) keying the value in the 
current units (cm or inches) in the relative field in the drawer and press 'return' to define the point. 

It is possible to lock one or more variables to an assigned value simply pressing the concerning icon or 
choosing from the keyboard the key to lock ('X', 'Y', 'Z', 'A', 'N', 'D', or 'x', 'y', 'z', 'a', 'n', 'd'): the relative 
button will be selected. 

To unlock all previous locked coordinate it is possible to type '<' key. 

In the bottom side of the window there is a status line with the active command prompt, indicating the 
command sequence to execute. 

3.1.1.1. Selection management 

The user enters the selection mode. The command stops every other active command and stands by for 
another selection set to be created. 

Selecting only one element the user will be able to modify its internal parameter by a double-click or by 
the command 'Edit'->'Info'->..., its geometry by the command 'Edit'->Reshape', and its local Coordinate 
System by the command 'Coordinate'->'Modify'. 

To modify the same parameters on more than one element, the user must modify one element of the 
group, activate the copy of its parameters (command 'Edit'->'Copy') and then paste the desired 
parameters to the group (command 'Edit'->'Paste Special...'). 

Multiple selections proceed holding down the key ⇧(shift key) and selecting or deselecting the desired 
element: if this is overlapped with others, the user will be able to make more clicks, holding down the key 
⇧(shift key), and then will be selected, in order, from the first to the last of the overlapped elements and 
then all together. 

Multiple selection may be done by the 'window selection' simply dragging a rectangle with the mouse that 
has to totally include the elements we want in the selection. 

 
An option for making a multiple selection is the 'crossing window selection' that consists in creating a 
dragging mouse rectangle, that intersects the wanted objects, with ⌘(command) key pressed: 
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Selecting flat surfaces the Application shows the local X and Z ax (highlighted in green), defining the 
direction of the 'observers’: 

 

3.1.1.2. Contextual menu 

The [second mouse button] or the ['ctrl' key + mouse button] sequences enable contextual menu if done on 
an element (or with an already done selection): this menu permits to enter in the 'Info' dialogue of the 
element and some specific commands relative to the selected elements. 

3.1.2. Plan view mode 

In the Plan view mode the drawer contains two group of check box (see the right image):  

The first group permits to enumerate the elements contained in the view, the others 
permit: 

• to draw the plan view in black and white (check box 'Black and White'); 
• to draw ruler; 
• to project selected elements in the opposite side of the first-selected face (check 

box 'Other side View'); 
• to draw each finite element frame  (check box 'Frame mesh'); 
• to rotate plan view  of a certain angle; 
• to fix the plan view text height; 
• to enumerate certain kind of elements. 

3.1.3. Result view mode 

The characteristics of this mode are explained in the § 4.9.2 Command: RESULTS. 
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3.2. Scene Kit window 
Selecting the menu 'Rendering' Scene Kit window for the active document will be opened: this has a 
drawer that permit to manage some parameters, following the next table (see right image at next page): 

• Background color can be chosen; 
• ‘Model check-box turn on the visualization of 3D-model linked to sources; 
• ‘Grid’ check-box make visible a reference grid on the XY plan; 
• 'Updt' button permits to regenerate the Scene Kit scene after some 

modification in the model; 
• ‘Fog’ box permits to add opacity to the scene, to make it more realistic, 

(see 4.9.4.1 Color Mapping): 
• ‘Result/Map’ check-box permits to map the calculation results: this option 

may be onerous for complex projects, and we suggest to flag it only 
when the user has chosen the view; 

• ‘Textures’ allow the textures visualization for the whole model; 
• ‘Saturation’ slide and edit field permit to set the maximum lux value 

mapped in the scene; 
• ‘Threshold’ slide and edit field permit to set the lux value below which the 

color will be mapped following the next field choice... 
• ‘Threshold color’ (see upward); 
• ‘False color results’ check-box permits to examine the lighting, choosing a 

Spectrum of color scale and a Luminance Filter (see 4.9.4.1 Color 
Mapping); 

• 'Simulated lights' check-box permits to light the scene with all the lighting 
source placed in the model but simulating their photometries as cone (see 
image at right-bottomn); If more than 8 source are placed in the model 
the user will be prompted to switch in 'Result/Map' mode; 

• 'General Intensity' slide permits to calibrate the whole effect of the 
simulated lights; 

• ‘Default lights’ permits to light the scene with the Ambient light (to 
calibrate the global brightness of the scene: intensity is controlled by the 
slide) and three spot lights, whose parameters are controlled through a 
specific ‘Settings’ dialogue (see images at the bottom-left of this page): 

o 'Model envelope radius' is the model envelope sphere radius; 
o ‘Intensity’ permits to calibrate the brightness of the spots; 
o X and Z position permits to adjust the spot position; 
o Inner is the angle, in degrees, of the area fully lit by the spotlight; 
o Outer is the angle, in degrees, of the area partially lit by the 

spotlight; 
o Color is selectable through the standard Apple color picker; 

• ‘Saved views’ permits: 
o to create a new view (button add); 
o to delete views (it is not possible to delete the first, button delete); 
o to bring as active a previously saved view (button set); 
o to rename existing view, editing it directly in the table. 

• Inside the scene it is possible to select and hide elements through a contextual menu that will be 
presented clicking on them: 

o Hide this permits to hide the selected element; 
o Show all permits to make visible all the elements make hidden with previous commands. 
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Navigation inside the SceneKit window is simple and proceed through the method of the 'Virtual sphere' 
using the mouse and the modification keys. To rotate use the procedures described below. 

Translation will be done with the ⇧(shift) key pressed and the zoom will be activated with the ⌥(alt) key 
pressed during the click-drag mouse procedure (using the trackpad it will be possible to zoom also with 
the 'open/close fingers' gesture). 

Finally, 6 buttons are presented, to rotate the view around X, Y and Z model axes: step interval follows 
the value saved for the main view rotations step (see §4.8.2.2 3D Space section). 

 
With the Scene Kit window in front, the ‘View’ -> ‘Save image for Report as ‘Rendering’’ menu permits to 
save the viewed image in the report file as ‘Rendering’ view (see § 4.2.18.1). 
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3.3. Mouse and data input 
The current position of the cursor is indicated always in the editable fields at the top left: the coordinates 
follow the Active Coordinate System in the plane Z=0 and in the current units (cm or in). The following 
keys carry out the procedure used in the generation of points: 

• The tabulation key cycles the active field (X -> Y -> Z -> X ->...). 
• The 'X', 'Y', 'Z' keys activate and alternatively lock and unlock the field at the relative variables 

(the 'N' key unlock them); this is particularly useful when you want give coordinates to points 
'taken' for alignments known and existing; 

• The ⌥(option) key when pressed make sensible the position of the cursor at existing points in the 
project, the existence is highlighted with a change of the form of the cursor to snap-cursor. 
Activating the auto-snap procedure it will be possible to snap to existing points without pressing 
the ⌥(option) key. 

Point’s introduction is done with a simple click of the mouse or by inserting numeric values in the current 
units (cm or in) in one or more fields (x, y, z) and pressing the ⏎(return) key. 

In practice, if you want to introduce a point at X=100, Y=200 and Z=300, in the Active Coordinate 
System it is enough to move the cursor until you read in the X fields the value '100' and in the Y field the 
value '200', introduce in the Z fields the value '300' and press ⏎(return), or introduce in the three fields 
the desired values and press ⏎(return). 

The introduction of the objects is done as in traditional CAD, following the mouse procedure “click-drag-
click”. Pressing the ⌥(option) key the user can attach tracking ("snap") to existing points: when the cursor 
passes near existing points the cursor becomes a circular point. The selection/deselection of more objects 
is done by pressing the ⇧(shift) key. Other kind of selection is the 'window selection' and the 'crossing 
window selection', described in the 'Menu'->'Edit' section. Pressing the ⌥(option) key holes will be 
excluded from the selection cycle. 

A double-click inside an element region opens the info-dialog of that element. 

3.4. Try points 
The combination ⌥(alt) + click assigns a 'try point', a particular function of Illuminando for precision input 
of ties or existing alignments. 

The sequence of the procedure is as follows: 

1. passing on an existing point the cursor highlights its existence. 
2. the combination ⌥(alt) + click takes the real coordinates of the point in the editable fields 'X', 'Y' 

and 'Z' of the main window. 
3. at this point, taking care not to move the cursor, it is possible to: 

• lock one or more coordinates; 
• modify with the keyboard one or more coordinate; 
• move to other fields with the tabulation key; 

4. finally, simply accept the present point in the editable fields with another click or by pressing 
⏎(return). 

Activating the auto-snap procedure it will be possible to snap to existing points without pressing the 
⌥(option) key. 

3.5. User surfaces 
Illuminando permits to define every surface, flatten or curved, as a 'user surface', to simulate audience 
arrangement or working plane, and to calculate, in addition to the horizontal, also the vertical and semi-
cylindrical illuminances, contrast rendering factors C.R.F. and glare indexes C.G.I. and U.G.R., ... 
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An user plane is a transparent virtual surface, that retains data relative to rays passing through it; 
measured points are placed in the barycenter of the finite elements of the same surface (defined by the 
calculation internal grids), and the local X-axis represents the viewing direction. 

A user surface can simulate, so, working plane in a factory, desktop in a school, audience in a theater or 
in a cinema hall,... 

3.6. Textures 
Illuminando 3 implements textures for both sides of ‘Face’ and ‘Object’ elements. 

Textures are bitmapped images that the application loads from the ‘Textures’ folder inside the library 
folder (see § 2 Getting started): in this way the user is allowed to add any bitmapped image (jpg, tif, 
bmp) to the ‘Textures’ folder, that will be presented in the textures list in the info dialogues. 

Texture will be mapped following the x-axis of each element and according to the scale parameter 
available in the info dialogues. 

The following image present a ‘Stone granite01’ textured quadric surface lighted by two projectors: 
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4. Guide 

4.1. Menu Illuminando 

4.1.1. Command: PREFERENCES... 

 
With this dialogue, in the 'General' tab it is possible: 

• to work with the preferred units: metric (cm, m) or imperial (ft., in); 
• to use lux or footcandle to examine illuminances; 
• with 'Confirm events', to disable confirm warning events like 'Are you sure to delete…'; 
• with 'Copy using minimal data', to copy only lux values in the result view while opening a mouse 

region (not applicable for roads – see 4.9.2 Command: RESULTS); 
• 'Dimension in specific layer' permits to force the dimension creation on their specific layer; 
• to define the text height for the dxf exportations; 
• to set the line thickness for the photometric curves plot; 
• to choose the default notification sound; 
• to define the scale of the pictures exported in the RTF files. 

4.1.2. Command: QUIT 

From this menu it is possible to exit the Application. 

4.2. Menu File 

4.2.1. Command: NEW 

This menu permits to create a new working session. 

4.2.2. Command: OPEN... 

This command permits to open an already-saved Illuminando file through the standard Mac dialog. 

It is also possible to open Illuminando projects through Drag & Drop procedures. 

4.2.3. Command: OPEN RECENT 

This menu presents a list of the last opened files, and it is possible quickly open one of it. 

4.2.3.1. Command: CLEAR MENU 

This command clears the list of the recent opened files. 
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4.2.4. Command: IMPORT 

Illuminando can import dxf or pdf files. 

4.2.4.1. Import DXF 

The importation proceed from DXF format (Drawing eXchange Format), tool that allows inserting 
bidimensional or tridimensional objects from almost all CAD applications in Macintosh and 
DOS/Windows environments (AutoCAD, ArchiCAD, DomusCAD, Vectorworks, etc.) or from a PDF (only 
2D) file. 

This command permits to import external objects inside an Illuminando file, choosing: 

• the Unity conversion, from the external file to the Illuminando file (may be cm or inches); 
• the approximation edge number to import circle or arcs; 
• to import the element contained in the external file as a single object of type Illuminando-free: it is 

important that the drawing must contain only dxf entities of type 3DFACE or POLYLINE, and these 
last with no more than 4 vertices. 

User has to notice that the DXF format contains less information than the ones Illuminando needs to 
correctly start calculation, so missing information will be assigned by default. 

For a correct DXF importation, it is important to notice that: 

• if possible, it is better to export DXF files without header, to permit in Illuminando a correct color 
reading; 

• Illuminando imports only dxf ARC , CIRCLE , LINE, POLYLINE, LWPOLYLINE, 3DFACE and 
INSERT (BLOCK) entities: 

o dxf-lines will be converted to Illuminando-lines; 
o dxf-open polylines will be converted to Illuminando-polylines 
o dxf-closed polylines will be converted to Illuminando-flat surfaces; 
o dxf-3Dfaces will be grouped, converted in free-form objects and saved in separated layer; 
o dxf-block will be converted in an Illuminando-symbol and presented as an oriented circle; 
o dxf-text will be imported without rotation. 

4.2.4.2. Import PDF 

The importation in PDF, allows inserting bidimensional objects from almost all applications in Macintosh 
environment. 

In this option too, the user has to notice that the PDF format contains less information than the ones needs 
to correctly start calculation, so missing information will be assigned by default. 

The file will be automatically converted into the Active Coordinate System, placed on the active layer and 
visualized on the screen. 

For a correct PDF importation, it is important to notice that Illuminando imports only arc, circles, lines and 
open or closed polygons: 

• lines will be converted to line; 
• open polygons will be converted in polylines, the closed one in faces. 

4.2.5. Command: ROOM WIZARD... 

The Room-wizard dialog will be presented: 
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Room shape may be: 

• rectangular with a generic ceiling; 
• L shaped, with flat ceiling; 
• cutted corner (and triangular for extension) with flat ceiling. 

In case of L-shaped or cutted corner will be activated two edit field that permit to 'cut' one room corner, 
following the next figures, in which X=Length, Y=Width: 

     
Ceiling of a rectangular room may be: 

• flat; 
• single slab (along X-axis); 
• single slab 90° (along Y-axis); 
• double slab (along X-axis); 
• double slab 90° (along Y-axis); 
• barrel vault (along X-axis); 
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• barrel vault 90° (along Y-axis); 
• cross vault; 
• dish vault. 

Colors may be chosen through the standard Mac procedure 

while in the dialogue is visible the current color with its number (ex. #248), its reflection coefficient (ex. 
r=72%) and its RGB components in % (ex. RGB { 75, 75, 75} ). 

The source catalogue may be chosen through the button at the bottom of the source list, containing the 
code and the name of the active one. 

To find some source it is present a find edit field under the source list: typing something inside it the 
Application will search for the sources whose name contains the typed characters. 

4.2.5.1. Selecting one or two ligting sources: Verify option 

Lighting sources involved in calculation may be of two types (selecting two rows in the source table list by 
pressing the ⌘ (command) key), and the 'Staggered' check box permits to have such a type of layout. 

The procedure start once the user choose the lux level required and press the 'Verify' button: the 
Application presents the number of fixture needed to reach the required lux level. Then the only 
parameters it is possible to change without making new calculation are the row number, the layout 
(standard or staggered) type and the calculation grid. 

Pressing the button 'Create room' a new project will start with the values displayed in the dialogue. 

4.2.5.2. Selecting more than two lighting sources: Compare option 

In case of selecting more than two sources the user can activate the "Compare" tool that permits to 
evaluate the performances of the selected sources, presented in the second tab of the panel as in the 
following image: 
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See §5.2   



  Guide 

User Guide © 2014-2023 23 Marcello Brocato and Ecleti - Roberto Panetta 

Rectangular room for a tutorial. 
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4.2.6. Command: ROAD WIZARD... 

It is possible to automatically draw a road section with (in centimeters/inches) lane number and width, 
pole distance, sources height, luminaire tilt and bracket length, sidewalks size and the position of the pole 
respect to these, height and orientation X+ of a virtual surface to calculate vertical (X+, Y+, X-, Y-) and 
semicilindrical (X+) illuminament, and other parameters as the following dialogue divided in two tabs, in 
which the first ('Parameters') permits to introduce the parameters and the second to analyze the 
optimization ('Results'): 

 
Sidewalks define the proximity zones and are useful to evaluate the SR parameter. 
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The "Layout" pop-menu may present a single side road with left-side or right side poles, a staggered pole 
disposition or a double side with pole in front or centrals: 

  

  
If the central reserve is present or the chosen layout is “Central pole” the Application will build only the 
left-side road (for symmetry reasons). The road surface may be of Class I or II, but it is possible to change 
the proposed reduced luminance coefficient q0 in the relative edit field. 

The calculation grid may be free or may follow the UNI10439, UNI11248/EN13201 or UNI11095 
standard. In case of free calculation the user can choose the calculation grid. 

The Application permits to introduce the driver age as a parameter in the K multiplier of the veil luminance 
in the TI glare calculation: 
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Checking the “Glare calculation” button the complete law calculation will be performed (observer 
position, TI calculation, ...). 

The source catalogue may be chosen through the button at the end of the source list, containing the code 
and the name of the active one. 

To find some source it is present a “find” edit field under the source list: typing something inside it the 
Application will search for the sources whose name contains the typed characters. 

To start the Road Optimization Tool, lighting source multiple selection and some fields permits to select a 
range of values from a minimum to a maximum with fixed step: 

• source model (with a multiple selection by pressing the ⌘(command) key or the ⇧(shift) key) 
• pole distance (type: minimum/maximum/step) 
• source height (type: minimum/maximum/step) 
• luminaire tilt (type: minimum/maximum/step) 
• arm length (type: minimum/maximum/step) 
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Finally the Application start to calculate all the possible combination of layout (each model at each source 
heights at each pole distances at each arm and for each tilt) presenting the results in the second tab: 

 
The table presents a series of column: 

• the number of simulation 
• the number of source model in the catalog 
• the source name 
• the specific power consumption per km/mile 
• the pole distance (if input as minimum/maximum/step) 
• the source height (if input as minimum/maximum/step) 
• the luminaire tilt (if input as minimum/maximum/step) 
• the arm length (if input as minimum/maximum/step) 
• the medium horizontal illuminament Em 
• the medium luminance Lm 
• the horizontal luminance uniformity Uo 
• the center-road luminance uniformity Ul 

and, for each observer “i” 

• the longitudinal lane luminance Lm(i) 
• the horizontal luminance lane uniformity Uo(i) 
• the longitudinal lane luminance uniformity Ul(i) 
• the lane glare TI(i) 
• the SR(j) and the TI(j) (UNI 11248/2011) parameter connected to every sidewalks 
• the intensity indexes D and G relative to the fixture. 
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It is possible to order the rows by a specific column value by clicking the column header, or reorder the 
column order dragging the choose one in the new position. 

Finally, it is possible to filter the results editing the threshold-values on the bottom of the window and check 
the relative button: the simulations that not respect these limits will be hidden. 

To simplify this procedure is present a 'Class' pop-up menu with the standard road classification that will 
fill for you the fields. 

The 'Export Result' button will save the whole table in a tab-delimited file, while clicking the 'Build selected 
configuration' button the Application exit the optimization result dialog and will build the chosen 
configuration. 

4.2.7. Command: AREA WIZARD... 

An 'area' represents an open zone like a parking, a square,... The 'Area' dialog will be presented: 

 

The first section of the dialogue permits to choose the lighting source. 
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The source catalogue may be chosen through the button at the bottom of the source list, containing the 
code and the name of the active one. 

To find some source it is present a find edit field under the source list: typing something inside it the 
Application will search for the sources whose name contains the typed characters. 

The Application also reports the efficiency of the selected model. 

The 'Source Group' button permits to assign the default group to the lighting sources through the standard 
Mac colour dialogue or through the relative field (in the range of 1-256): 

The next section refers to the geometry of the model and in particular (in the near-bottom box are 
presented the explanation graphics): 

1. Corner light masts: light-masts will be placed at 
the corner of the area and according to the 
'Basket' setup it is possible to have a 90° open 
circular distribution of the fixtures.... 

 

...or a rectangular matrix of 'Rows' x 'Columns' 
at 'Grid' intervals, oriented in the XY plan 
following the 'Azimuth' angle and tilted of a 
'Zenith' angle; 
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2. Distributed light masts: a regular matrix of 
'rows' x 'columns' of light-masts will be placed 
with a 180° open circular distribution of the 
fixtures at the top; 

 

3. Distributed poles: a regular matrix of 'rows' x 
'columns' of poles with a single fixture will be 
placed 

 

4. Perimetral poles: poles with a single fixture will 
be placed only along the perimeter of the 
area, in the number of 'row' along the Y edges 
and 'column' along the X edges 

 

5. Faced poles: poles with a single fixture will be 
placed only along the X edges of the area, in 
the number of 'column' 

 

• 'Length X', 'Width Y' are the dimensions of the area; 
• 'Surface Grid' is the finite elements dimension for the lighting calculation; 
• ‘19x11 point grid’ fix the grid to divide the surface in n.19x11 rectangular finite elements; 
• 'Pole height Z' is the height of each pole/mast; 
• ‘Create poles’ permits to add the poles in the model; 
• 'Pole Rows' and 'Pole Columns' define the pole/masts matrix distribution; 
• 'Pole ∆X' and 'Pole ∆Y' define the pole distances from the field corners. 

The fixture basket may be circular or rectangular, and the available parameters are: 
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circular basket: 

• 'Number of fixtures' fix the number of light sources to 
distribute roundly (180° or 90°) at the top of each 
mast; 

 

rectangular basket: 

• 'Rows' fix the number of rows in the basket; 
• 'Columns' fix the number of columns in the basket; 
• 'Azimuth' fix the planar orientation of the basket 

(angle in the XY plan from the X axis); 
• 'Zenith' fix the inclination from the vertical of the 

basket (angle from the Z axis); 
• 'Grid' fix the distance among fixtures in the basket (∆x 

and ∆y);  

• The 'Add lines' pop-menu permits to add the particular game lines in the plan. 
• The 'Metaproject' box use the CIE method to evaluate the number of the selected fixtures to reach 

a specific illuminament level, in function of the area dimension and the poles height. 
• The 'Create surface' check-box permits to include or not the surface creation in the model. 
• The ‘Calc GR 10x4’ check box add an user surface for calculating glare GR in a grid of 10x4 

finite elements; 

Pressing the button 'Create area' a new project will start with the values displayed in the dialogue and the 
application shows the scene in 3D mode view. 

See §5.1 Open area for a tutorial. 
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4.2.8. Command: SOURCE LIBRARIES MANAGER 

The main window is divided into 4 sections: 

• Photometry: permits to navigate and modify the photometric solid 
• Catalogue: permits to manage catalogue on disk 
• Fixture: permits to modify geometrical, electrical,... characteristic of the fixture 
• Lamp: permits to view/select lamps 

 

4.2.8.1. Photometry section 

The view presents the 18 azimuthal sections of the photometry in candle for 1000 lumen with different 
colors for each curve or the I-table, according to the 'View' pop-up menu. Many options are possible: 

• With the pop-up 'Operations' it is possible to modify the active photometry, and in particular it is 
possible on a single or multiple selection (after all these procedure, to maintain the modified 
photometry it is necessary to save it with the item 'Save Fixture' in the 'Fixture' section): 

o to correct efficiency of the selected luminaires: permits to evaluate the ratio between the 
luminaire emitted flux and the total installed one: the user can scale the photometry to 
balance this value on a more correct one, following the side dialog; value can be entered 
also as a series of simple operation (without parenthesis or precedence order) like 
'100*45,12/36'. 

o to rotate the azimuth of the whole photometry at 10° or 90° steps, clockwise or counter-
clockwise, for example to overlap the C=0 axis of the imported photometry with the 
frontal axis of the Illuminando source, if the first does not respect the CIE-standard (this is 
possible importing IESNA formats); 

o to rotate the zenith of the whole photometry at 90° steps, up and down; 
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o to mirror the left side of the photometry to the right side and vice-versa, respect to the 
C=0-180°; 

o to reassign the photometry as the average of the left side and the right side, respect to the 
C=0-180°; 

o to reassign the photometry as the average respect of the vertical axis and rotating it 90° 
in the azimuth; 

o to sum the selected photometries (only multiple selection). 
• Through the pop-up menu 'Plot' it is possible to choose the section or combination of sections to 

show; 
• The edit field 'Full scale' assign the diagram Y scale ratio: a 0 value let the software to choose the 

best value; 
• The pop-up menu 'View' permits to display the photometry as polar, Cartesian, I-table or 3D view 

(C-sections are plotted following the C-curves colors). 

  

  

 

  



  Guide 

User Guide © 2014-2023 33 Marcello Brocato and Ecleti - Roberto Panetta 

In the I-table view mode the user can modifying a single value by editing the relative field in the list: the 
Application will answer requiring an interval (called “elastic interval”) to smooth the final result following 
a sine/cosine surface interpolation: 

 

In the 3D view navigation is possible through the standard Mac mode: 

• click + drag = rotate; 
• right-click + drag = pan; 
• alt + click + drag = zoom. 

4.2.8.2. Catalogue section 

This section presents the active source catalogue and a list of its enclosed luminaries alphabetically 
ordered: choosing a luminaire, the element identifier will be pasted in the relative edit field that make 
possible to change its name. If the user wants to save information in the specific "photo" fiald about the 
optic of the luminaire, it is possible to insert the "#" char folloved by the optic description without spaces 
(for axample, typing "#road_01" the application will present "road_01" in the "photo" column). 

It is possible to make multiple continuous (⇧-shift key pressed) or discontinue (⌘-command key pressed) 
selection for particular modification to the selection set. 

Furthermore it is possible to order the list of fixtures alphabetically by clicking the column title. In this 
section it is possible: 

• to add a luminaire copied from the selected ones (button '+' and also available as contextual 
menu); the program asks for sizing flux and power of the new fixture to a new value of total 
power, according to the following dialogue:  

 
• to delete the selected luminaires (button '-' and also available as contextual menu); 
• to create a new empty Catalogue; 
• to open an existing one: the active one is highlighted in the field under-center the source list; 
• to merge an existing one into the active catalogue; 
• to create a photometry by equivalent openings. The application open a dialogue asking for the 

needed parameters and will build the relative rectangular: photometry: 

 
• to import a single photometry, saved in EULUMDAT, IES or TM14 format (see 4.2.8.2.1 Importing 

photometries); 
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• to import a whole photometry folder included all subfolders, saved in EULUMDAT, IES or TM14 
format: in this case the software asks for some options: it is possible to rotate each photometry at 
10° step clockwise or counterclockwise, to include in the Illuminando identifier: 

o label the file name, data bank, version and format; 
o the Company luminaire catalog number; 
o the Company luminaire name; 
o to import all the bulbs with which the luminaire is powered (only EULUMDAT format) 

following the dialogue: 

 
• to save the current catalogue; 
• to save a copy of the current catalogue; 
• to link a price file to the active catalogue, simply choosing it through the standard Macintosh 

dialogue: the linked one is highlighted under-left the source list; 
• to unlink any price file from the active sources catalogue; 
• to join code and model strings in a single label that will replace the model label, far all the 

selected photometries; 
• to swap code and model strings, far all the selected photometries; 
• to export all the luminaires in the active catalogue as a simple list of sources in plain text format 

with tab delimiters, formatted as 'Model' - 'Input flux' (Lamps number x Lamp flux) - 'Output flux' 
(Luminaire outgoing flux) - 'Efficiency %' (Light Output Ratio); 

• to export the selected luminaries as: 
1. IES-NA photometry file, and it is possible to personalize some fields as in the next figure: 

 
2. EULUMDAT photometry file; 
3. PDF drawing file; 
4. PDF protocol that may include: 

o the longitudinal section (C=0/180) of the luminary’s photometry; 
o the longitudinal (C=0/180) and the transversal (C=90/270) section of the luminary’s 

photometry; 
o all the sections of the luminary’s photometry; 
o all the numeric fields defining the photometry (I-table); 
o the luminary’s picture. 
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5. Collada (DAE) 3D file (if the 3D view is activated in the 'View' pop-menu); 

• to find lighting sources that contain a specific text inside the model name or to replace all the 
occurrences of a certain text string in the selected sources (once activated the 'Replace' field 
through the toggle menu inside the 'Find' edit field); moreover, typing '#' followed by a number N 
the application will cut from the name the first N characters; 

• to copy in a single text string the code and the model of the selected source (also available as 
contextual menu); 

• to copy the selected photometries in the Brotens native format for pasting them in another 
catalogue; 

• to paste the previously copied photometries in the active catalogue; 
• to copy the active photometry in PDF format; 
• to copy the active photometry in PNG format. 

4.2.8.2.1. Importing photometries 

Illuminando permits to import photometric data from IES-NA, EULUMDAT, TM14, PDF or DXF files. 

The user will be prompted with the following dialogue, to save the photometry rotating it at 10° steps, 
clockwise or counter-clockwise, with an Illuminando identifier containing or not: 

• the file name, data bank, version and format; 
• the Company luminaire catalog number; 
• the Company luminaire name 

...and to import all the bulbs with which the luminaire is powered (EULUMDAT format): 

 
For text files, Illuminando will try for the first time the IES-LM-63 format (to format a file in such a way see 
Appendix C: IES-NA data interchange format). If this is not a correct filter, the Application reply with an 
alert and try EULUMDAT filter (to format a file in such a way see 5.10 Appendix D: EULUMDAT data 
interchange format) and finally the TM-14 filter will be tried. 

If the luminaire to import has the possibility to install different bulbs (EULUMDAT formats), the Application 
will display a dialog for choosing the configuration to present. 

Illuminando can import also PDF or DXF drawing as photometry, that must contain the following 
information: 

• a couple of lines drawn in BLACK crossing in the center of the real photometry if drawing a polar 
diagram or an horizontal black line and (optional) a YELLOW line perpendicular in the middle 
point of the first if drawing a Cartesian diagram; 

• a text object indicating the maximum intensity value (optional); 
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• a polyline or some connected lines drawn in RED (or a mainly-red color – ex.: RGB={0.8, 0.1, 
0.2}) defining the C=0, C=180 sections and containing the center of photometry; 

• a polyline or some connected lines drawn in BLUE (or a mainly blue color – ex.: RGB={0.2, 0.1, 
0.8}) defining the C=90, C=270 sections and containing the center of photometry (optional but 
the first to use if the red one is present); 

• a polyline or some connected lines drawn in MAGENTA (or a mainly magenta color – ex.: 
RGB={0.8, 0.7, 0.1}) defining the C=60, C=240 sections and containing the center of photometry 
(optional but the first to use if the red and blue ones are present); 

• a polyline or some connected lines drawn in CYAN (or a mainly cyan color – ex.: RGB={0.2, 
0.7, 0.8}) defining the C= 10, C=190 sections and containing the center of photometry (optional 
but the first to use if the red, blue and magenta ones are present). 

• a polyline or some connected lines drawn in GREEN (or a mainly green color – ex.: RGB={0.2, 
0.7, 0.2}) defining the C=30, C=210 sections and containing the center of photometry (optional 
but possible to use only if the other colors are present). 

Opening the DXF file, if not present in the file, the Application asks for the maximum intensity in the 
selected photometry, to bring the drawing to the real scale. Photometry to import may be drawn as polar 
or Cartesian diagram, following the next indications: 

Drawing a polar representation Drawing a Cartesian representation 

 
 

4.2.8.3. Fixture section 

In this section it is possible: 

• to save the modified luminaire ('Save fixture' button). The label inserted in the edit field may 
contain some code characters: 

o a couple of round brackets with a fraction '(1/N)': this case means for the software, in the 
evaluation exportation, that the fixture is a part of a bigger luminaire composed by N 
identical parts (es. 'fixture AAA (1/3)'); in the price list the cost of the fixture has to be 
divided by N and finally in the computation it will be reassembled with the price brought 
to the original cost; 

o some text included in square brackets '[...]' will be omitted in the report. This opportunity 
is useful to connect luminous parts (saved as photometries) of the same fixture: the part of 
the label external to the brackets '[...]' has to be the same, while inside the brackets the 
part may be evidenced, taking care to highlight with a '+' sign all the secondary parts (es. 
'fixture AAA[part 1]', 'fixture AAA[+part 2]', ...). 

• to assign dimensions and luminous volume. Luminaire geometry is defined through its “Bounding 
box” (needed for shadow calculation) and its “Luminous box”, both described as box oriented in 
the Local Coordinate System of the lighting source as in figure: 
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• Because of the local X-axis in Illuminando is the C=0° axis, for compatibility with the interchange 

formats it is present the “x <-> y” button, that permits to invert the fixture dimensions along the 
local axis; 

• to assign total power (that take count of electronic parts and of what the luminaire needs to 
function; it is possible to input this field as an absolute value, es. '120', or as a percentage of the 
lamps power, es. '20%') and maintenance factor (must be choose on low values 30%÷50% for 
dusty luminaries and/or rooms, and on better values 70%÷90% for new luminaries and/or clean 
rooms, not involved in calculations); for poly-sources a zero value let the software calculate this 
quantity in function of the lenght of the polyline; 

• to assign the total flux of the fixture, that take account of the Light Output Ratio of the Luminaire 
(not involved in calculations); for poly-sources a zero value let the software calculate this quantity 
in function of the lenght of the polyline; 

• to assign blind height and antiglare grids; 
• to control emitted flux, and in particular: 

o efficiency; 
o 0°-30° emitted flux; 
o 0°-40° emitted flux; 
o 0°-60° emitted flux; 
o 0°-90° emitted flux (DLOR = downward luminaire output ratio); 
o 90°-120° emitted flux; 
o 90°-130° emitted flux; 
o 90°-150° emitted flux; 
o 90°-180° emitted flux (ULOR = upward luminaire output ratio); 
o 0°-180° emitted flux (total). 

• to control equivalent light-cone (those angles in which the intensity decay at 50% of the one 
measured at gamma=0°) ; 

• to control the CIE class (the official CIE classification for the fixture) end Intensity Class D and G; 
• to force the assignment at Intensity Class D.0 through the check box (if the bulb or its image is 

visible from an angle of 85° from the vertical, according to the D.0 definition); 
• to link/unlink an image to the fixture, that has to be contained in the 'Picture' folder inside the 

'Luminaires' folder (choosing 'Cancel' the user can delete every link to the element); 
• to link/unlink a 3D dxf-model to the fixture, that has to be contained in the 'Models' folder inside 

the 'Luminaires' folder (it is important that the model will have origin O and spatial orientation 
equal to the Illuminando scheme to have a correct visualization inside SceneKit and with the 
convention that all the dxf-elements drawn in color #0 represent the luminous parts of the fixture, 
and in Illuminando will be drawn in the source color); 

• to examine illuminament diagram on a standard flat squared LxL horizontal surface with the active 
source placed in the center  of the area ("Sym." button, left picture) or in the left-middle edge 
("Asym." button, right picture) at L height. The front red curve represent the available average 
illuminament as the parameter L changes: 
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The '>' button, if present, permits to automatically assign the actual value to all the selected elements in 
the source list of the active Catalog. 

4.2.8.4. Bulb section 

Bulbs installed in the lighting source will be characterized with the following parameters: 

• type of emission spectrum; 
• number of installed ones; 
• power of the single bulb in Watt; 
• conventional bulb name; 
• lamp holder type; 
• luminous flux of the single bulb in Lumen; 
• correlated Color Temperature and RGB color. 

It is possible to change the proposed Color Temperature simply editing the new value in its field or clicking 
right side coloured button. 

The main dialogue presents, finally, a list reporting some of the most common commercial lamps, for a 
quick selection through a double click. 

The '>' button, if present, permits to automatically assign the actual value to all the selected elements in 
the source list of the active Catalog. 

The bulb database is contained in the "Lamps.txt" file is a simple text file that can be edited with whatever 
software but saved as text file. 

The file has the following structure: 

class NBS W Lm K Holder Company Identifier x y ∆uv Type 

T5 35 3650 4000 G5 - T5 tube . 3855 . 44017 . 02559 FLIN 

...           

The first line is the header; follow the real lamp records, one each row. 

Each field in a record is separated by a 'tab' code. 

  



  Guide 

User Guide © 2014-2023 39 Marcello Brocato and Ecleti - Roberto Panetta 

The user has to introduce a new lamp at the correct row, following the last field 'Type' in which: 

Identifier description   Identifier description  

FCOM compact fluorescent   NAHP sodium high pressure  

FLIN linear fluorescent   NABP  sodium low pressure 

HALO halogen   INCA incandescent  

HGVA mercury vapor   LED_  led  

JMET  metal halide  XENO xenon 

 

The operation is to insert a new record as a row inside the correct lamp group, then each field of the 
record has to be filled: 

class NBS  standard lamp name;  

W  nominal power consumption  

Lumen nominal lumen output  

K Kelvin color temperature of the source  

Holder  lampholder 

Company  Company 

Identifier  Commercial name 

x x-coordinate (CIE 1931)  

y  y-coordinate (CIE 1931) 

∆uv distance from the Black Body curve in the CIE 1960 diagram  

TYPE internal identifier for the lamp type (one of the name in the previous table) 

Once finished, the user has to save the file as text file with the name "Lamps.txt" in the same directory of 
the original one. 

See § 5.4 Manage photometries for a tutorial. 
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4.2.9. Command: BULB LIBRARY MANAGER 

Selecting the command, the Bulb manager dialog will be presented: the first box 'Spectra' permits to 
open, examine and save spectra data. The following image present an already opened spectra in XML 
format... 

 
...and another spectra in CSV format: 

 



  Guide 

User Guide © 2014-2023 41 Marcello Brocato and Ecleti - Roberto Panetta 

Once opened the application calculate the color and the color temperature of the source and display 
them at the bottom of the graphic. The method to calculate the real lighting source color is through the 
opened emission spectra spd(i) weighted by the human visibility curve V(i) to reach the (X, Y, Z) color 
coordinates, then calculate the (x, y), (u, v) and (u', v') to describe the color point in the CIE 1931, CIE 
1960 and CIE 1976 diagrams and finally it is possible to calculate the color temperature cct as function of 
the (x, y) color coordinates: 

n = 
x - 0.332
0.1858 - y ; cct = 449·n3 + 3528·n2 + 6823.3·n + 5520.33 

There are four commands available: 

• Open...: permits to open an XML file formatted following the IES TM-27-14 IES Standard Format 
for the Electronic Transfer of Spectral Data or a CSV file: once opened, the application calculate 
the spectra color and will round up the color temperature in K; 

• Copy plot: permits to copy the graphic in PDF format; 
• Report: permits to export the calculated data and the graphics in PDF format, as the in following 

image: 

 



  Guide 

User Guide © 2014-2023 42 Marcello Brocato and Ecleti - Roberto Panetta 

• Save: permits to save the current spectra in the 'Lamps.txt' library inside the service folder of 
Brotens applications before saving the user has to fill the Information in the relative box for saving 
fields. 

The second box 'CIE diagrams / comparison' of the dialogue permits to examine the CIE 1931, CIE 1960 
and CIE 1976 diagrams where the color point of the opened sources is plotted, and to compare two 
spectra (the following image present the two previous sources already opened as A and B): 

 

There are six commands available: 

• CIE 1931 - copy: permits to copy the relative graphic in PDF format; 
• CIE 1960 - copy: permits to copy the relative graphic in PDF format; 
• CIE 1976 - copy: permits to copy the relative graphic in PDF format; 
• Open source A: permits to open an XML file formatted following the IES TM-27-14 IES Standard 

Format for the Electronic Transfer of Spectral Data or a CSV file; 
• Open source B: permits to open an XML file formatted following the IES TM-27-14 IES Standard 

Format for the Electronic Transfer of Spectral Data or a CSV file; 
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• On the fly comparison, permits to insert manually two color-temperatures (pop menu 'CCT') or two 
CIE1931-colours (pop menu 'x, y') or two CIE1960-colours (pop menu 'u, v') and compare them 
as explained later: 

 
• Comparison report: permits to save the calculated data and the graphics in PDF format, as in the 

following image: 
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The comparison is presented (following the ANSI_NEMA_ANSLG C78.377-2008 - Specifications for the 
Chromaticity of Solid State Lighting Products - American National Standard): 

• in the '∆uv A-B' field as the distance of the colors in the CIE 1960 diagram; 
• in the 'SDCM' field that present the minimal McAdam ellipse that include this distance; 
• in the '∆CCT' field that present the color temperature tolerance for the selected McAdam ellipse. 

Parameters follow the next table: 

∆uv A-B  SDCM  ∆CCT  

< .0007  1x  ±30K  

< .0010  2x  ±60K  

< .0015  3x  ±80K 

 < .0020  4x  ±100K  

< .0060  7÷8x  ±175K 

 > .0060  >8x  ...  

The third box of the dialogue present the bulbs database in the Brotens service folder: 

 
The bulbs database is contained in the "Lamps.txt" file: it is possible to find the description of this file in the 
paragraph 'Bulb Manager'. 

See § 5.5 Manage spectra data for a tutorial. 
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4.2.10. Command: MAINTEINANCE FACTOR MANAGER... 

With this tool it is possible to evaluate the maintenance factor for fixtures with led and PMMA lenses: 

 
• the ‘Protection glass’ box checked permit to evaluate M.F. for fixtures in which leds are protected 

with a glass; 
• ‘Atmosphere’ may be clean or dusty (smog areas, heavy factories,...) 
• ‘Driving current’ may be chosen among: 

o 50-550 mA; 
o 600-900 mA; 
o 95-1050 mA. 

• the user has to fix also the cleaning cycle among the following: 
o 4.000 hours; 
o 8.000 hours; 
o 12.000 hours; 
o 16.000 hours; 
o never. 

Finally, choosing the time at which the M.F. has to be calculated (from 4.000 to 100.000 hours) the user 
will read the result (in red in the upper figure). 
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Follows one of the graphics on which the tool is based. 
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4.2.11. Command: SERVICE FOLDERS... 

This command permits to manage the Application service folders. The first time the Application runs the 
user is prompted for locating these folders: 

 
Once chosen, the Application initialize it. It is possible to reset the service folders in every moment simply 
choosing this menu and pressing the 'Reset Library Folder...' button: 

 
...or navigating inside it through the button 'Open Library Folder'. 

4.2.12. Command: CLOSE 

This command permits to close the current project. 

4.2.13. Command: SAVE 

This command permits to save the current project. 

4.2.14. Command: DUPLICATE 

This command permits to duplicate the current project. 

4.2.15. Command: RENAME 

This command permits to rename the current project. 

4.2.16. Command: MOVE TO... 

This command permits to move to another folder the current project. 

4.2.17. Command: REVERT TO... 

This command permits to recall the last saved versions. 
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4.2.18. Command: EXPORT 

This command allows the saving of work in different formats for compatibility with other programs of CAD, 
graphics, text, database, etc... The possibility to exchange information with other applications has the 
purpose to permit the maximum action freedom for the user in compiling drafts and technical reports, 
showing the results of the calculations. Available export formats follow. 

4.2.18.1. Export TEXT, RTF format 

The Application will create a complete calculation report with which it is possible to read numeric results 
and chromatic and spatial coordinates of all the elements in the project. 

If the user has made a selection set, the Application will export information and results only for the 
selected elements; in the other case the whole project will be registered. If TEXT was selected, the 
Application will export a TEXT file with tabulation, while for RTF/RTFX (Rich Text Format) export the 
Application will use a template (one fore each currency and/or customer) created ad formatted by the 
user. In the example-file are present every styles needed for a correct printing of the report, and the user 
will be able to change them, leaving the number of tabulations and, if possible, the width of the fields. 

In the RTF templates, it is possible to insert some automatic information through some codes (case is 
relevant): 

• #1 = The image saved in the slot 'Cover Design'; 
• #A = Agent name; 
• #D = Actual date; 
• #h = Actual time; 
• #N = File name (complete directory); 
• #C = Customer name; 
• #R = Reference and place; 

Fields to include in the exportation are selectable by the following dialog: 
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The other saved drawing slots, 'Layout design', 'Result Design' and ‘Rendering’ will be inserted in their 
opportune places inside the report. 

Buttons refer to the following dates: 

• (List of) Flat Surfaces: 

Number, Level, Type of surface, Area, Color of the upper/lower side (number, name, reflection 
coefficient), Calculation grid; 

• (List of) Openings: 

Number, Owner Type, Owner Number, Total glass thickness, Extinction coefficient, Color (number, name, 
transparency coefficient); 

• (List of )Lighting Sources: 

Number/Reference to the model, Model, Total power and flux with dimming percentage, Number of 
Lamps, Lamp type, Lamp label, Lamp socket, Lamp power, Lamp luminous flux, Lamp color, Total installed 
power, Maintenance factor, X/Y position, Installation height, Pointing (x, y, z/azimuth, zenith); if this field 
is checked will export in the report the last viewed image in the “Project Source” session. If Detailed is 
active also: Catalogue, Level, anti-glare shader height, anti-glare shader angles, anti-glare grid height, 
anti-glare grid x,y dimensions. If Photometries is active also photometric diagrams with the curves visibility 
selected in the relative pop-menu 

• (List of) Objects: 

Number, Level, Type of surface, Color of the upper/lower side (number, name, reflection coefficient), 
Large Grid [cm], Calculation grid or number of X-Y divisions if a mesh; 

• (List of) Lines: 

Number, Level, Total length, Color number (group), Thickness; 

• (List of) Polylines: 

Number, Level, Total length, Color number (group), Thickness; 

• (List of) Cameras: 

Number, Position; 

• Daylight Data: 

Place, Latitude [°,’], Day, Month, Hour, Direct Radiation [W/m2], Diffuse Radiation [W/m2], Albedo [%]; 

• Titles from Level 2: 

Start title indentation from level 2; 

• Quality parameters: 

For each user surface: Number, Minimum horizontal illuminance, Maximum, Mean, Minimum/Mean 
illuminance ratio, Minimum/Maximum illuminance ratio, Mean/Maximum illuminance ratio; if this field is 
checked the Application will export in the report the last viewed image in the “Results” session; 

• Number of quality fields: 

The Application will prepare the number of quality fields relative to some surfaces the user want to insert 
in the report; 

• Plan detailed info: (for the roads) 

Road width, sources layout type, sources inter-distance, sources height, source beam, source beam tilt 
angle, luminaire label, bulb type; 

• Road Classification EN13201: (for the roads) 
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Tables contained in the EN13201; 

• Road pavimentation: (for the roads) 

The r-values of the reduced luminance coefficients of the road pavimentatioin used in the calculations; 

• Computation: 

Prizes for each fixture and each special piece, in the currency exportable to the estimation, are saved in 
the same folder of the source catalog (ex.: “Fixtures”) in a text file with the same name of the catalog and 
the “.prz” or ".txt" extension (ex.:”Fixtures.txt”). This file must contain the same list of lighting sources as 
in the Application catalog, and will be filled by the following fields, separated by tabulations: 

element description (it must be the same character string with which the Application recognize the element 
– to export in text format these identifying strings for a whole catalog, see 0   
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o Command: SOURCE LIBRARIES MANAGER 
o price in the first currency (ex.: “English” -> £) 
o price in the second currency (ex.: “Italian” -> €) 
o price in the third currency (ex.: “German” -> €) 
o … 

Description  currency 1 currency 2  currency 3  ....  currency n  

Fixture #1 10.6 8.44  100.5  ...  128.7 

Fixture #2 33.6  456.9 345.1  ...  789.0 

... ... ... ...  ...  ... 

Fixture #m  236.9  16.8  444.8  ...  100.5  

Only viewed elements will be exported, and in particular: 

o for each line and polyline: Number, Group (color), Description, Length, Quantity, Prize, 
Total; 

o for each special piece (to select manually): Number, Image (if saved), Description, 
Quantity, Prize, Total; 

o for each installed lighting source model: Progressive number (1, 2, …) and local reference 
(A, B, …), Image (if saved), Description, Image (if saved), Description, Total power, 
Quantity, Prize (if saved), Total. 

If the option Computation as table is active it is possible to export computation as table with formulas The 
software, finally, will automatically update the 'Summary.txt' database (saved in the same folder of the 
Application) filled with the list and the summary data of the RTF, RTFX or TEXT exported projects. 

4.2.18.2. Export DXF format 

Selecting 'DXF' from the sub-menu the selected element will be saved in DXF format or, if no selection is 
present, the whole project: 

• translating lines in LINE elements; 
• faces in POLYLINE elements; 
• furniture and free objects will be 'exploded' in 3DFACE elements, each put on a layer whose 

name is that one of the starting element plus a progressive suffix (Es. starting layer = ‘Walls’ ; 
ending layer = ‘Walls#o1’ ;...); the other object type will be exported as POLYLINE mesh; 

• lighting sources will be exported in INSERT (BLOCK) elements schematized as a circle. 

In the result session, the exportation will involve numeric fields and iso-value curves, in the other case the 
user will be prompted to assign the exportation scale (from centimeters/inches to…): 

 
The 'Explode objects' check-box permits the objects exportable as poly-mesh to be 'exploded' in 3DFACE 
elements. 

4.2.18.3. Export in COLLADA format 

If the Scene Kit window is opened, selecting 'Collada (3D scene)' from the sub-menu a .dae object 
containing the actual scene will be saved. 
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If the user doesn’t want to export all hidden elements the relative check box has to be flagged. 

4.2.18.4. Export in JPEG format 

Selecting 'JPEG' from the sub-menu, a JPEG image clipped from the screen will be saved. 

4.2.18.5. Export in PDF format 

Selecting 'PDF' from the sub-menu, a vectorial PDF file clipped from the screen will be saved. 
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4.3. Menu Elements 
Remember that to exit the command the user must press the 'Escape' key. 

4.3.1. Command: WALL 

This command permits to introduce a 4-vertices flat surface, starting from a base assigned with two generic 
space points. The Application asks for two points defining the base needed for the wall extrusion, that 
goes on, following the selected parameters in the extrusion options, in the Active Coordinate System. For 
example, assigning for extrusion parameters the vector {0, 0, dz} will create the element in the figure: 

 

4.3.2. Command: FREE FACE 

Permits to draw a flat surface in a generic 3D space plan, assigned y the first three input points. The 
procedure ask to insert the first three points of the building flat surface as new Coordinate System: next 
points will refers to the new Coordinate System. 

4.3.3. Command: FACE 

A flat surface is defined by its polyline contour, and may include openings (hole, glass or different color 

parts). The element is introduced on the XY plan of the Active Coordinate System, placing points 
consecutively, no matter if clockwise or counter clockwise: the first and second points define the local x 
axis direction, while the first and third points define the positive semi-plan for the element, following the 
figure: 

 
To close the boundary polyline it is possible to make a double click on the last point of the surface (point 
“n” in the figure) or making a simple click on the polyline’s initial point (point “0” in the figure). Closing 
the surface, the local Coordinate System will be placed in the barycenter of the face. 

4.3.4. Command: OPENING 

This item is active only if the user selects one (and only one) flat surface inside which it is possible to 
introduce hole, glasses or different color parts. The Application automatically brings the Active Coordinate 
System onto the surface’s plan, and lets the user introduce the polyline defining the boundary of the 
opening. The next steps are identical to those taken for introducing flat surfaces, but with a limitation in 
drawing that does not permit the assignment of points outside the flat surface to which the opening 
belongs. 
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4.3.5. Command: LIGHTING SOURCE 

This command permits to introduce a lighting source by three points. The procedure asks for the 
introduction of the source position (barycenter of the luminous opening - point 0 in figure), the pointing 
axis (Z local axis - point 1 in figure) and the frontal axis of the source (C=0° - point 2 in figure): 

 
In every moment, during the introduction of the three points needed to assign the position and orientation 
of the element in the space, it is possible to execute a mouse double click: in this case the orientation 
procedure will be stopped, end the element placed: 

 
• with the pointing axis oriented to the negative side of the Active Coordinate System Z axis; 
• with the frontal axis oriented to the positive side of the Active Coordinate System X axis; 
• with the transversal axis parallel to the Active Coordinate System Y axis. 

4.3.6. Command: OBJECT 

The command permits to introduce an object among those available. The procedure asks for the position 
of the origin of the object (point 0 in the figures), the direction of the local X axis (point 1 in figure) and 
the direction of the local Y axis (point 2 in the figures), like in the following figures, in which the local axis 
for every type of object are drawn. 

 
In every moment, during the introduction of those three points needed to assign the position and 
orientation of the element in the space, it is possible to execute a mouse double click: in this case the 
orientation procedure will be stopped, and the element placed following the Active Coordinate System. 
Available objects are displayed in the next figure. 



  Guide 

User Guide © 2014-2023 55 Marcello Brocato and Ecleti - Roberto Panetta 

table chair box 

bed armchair ellypsoyd 

cylinder cone circ.sector 

cross vault 
semi cross 

vault quadric 

dish vault circ.fillet dome 

torus stair basket 

Z

Y

X

∆X

∆Z

∆Y

thickness

Z

Y

X

∆X

∆Y

∆Z

armrest
Z

Y

X

∆X
∆Y

∆Z

shelves

back
panel

Z

Y

X

∆X

∆Y

∆Z

thickness

Z

Y

X

∆X∆Y

∆Z

thickness

Z

Y

X

Thickness
∆Z

∆X

∆Y

n.steps

X
Y

Z
n.Y fixing

n.X fixing

∆X

∆Y



  Guide 

User Guide © 2014-2023 56 Marcello Brocato and Ecleti - Roberto Panetta 

4.3.7. Command: LINE 

Permits the introduction of a single line. The procedure asks for the introduction of two points laying 
everywhere in the tridimensional space: the A vertex (point 0 in figure) and the B vertex (point 1 in figure) 
of the line: 

 
Once the line is drawn its middle point will be visible (is this option is checked in the Preferences) and 
snappable. 

4.3.8. Command: POLYLINE 

It is possible to create open polylines: the element is introduced on the XY plan of the Active Coordinate 
System, placing points consecutively with Z coordinate that may be different from zero. To end the 
polyline the user has to make a double click: 

 

4.3.9. Command: POLYGON 

It is possible to create a polygon that can approximate an arc: the element is introduced on the XY plan of 
the Active Coordinate System, placing up to three points; the end of the arc may be done by a double-
click in every moment: if the information given until this moment are enough to draw the arc, this will be 
placed. 

 

4.3.10. Command: CAMERA 

It is possible to introduce up to five (six for roads) cameras (observers). The position of the camera in the 
drawing will be marked with the symbol: . 

If the user inserts more than 2 observers the ‘CRF’ = Contrast Rendering Factor wil be no more available 
for ‘user’ surfaces. 
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4.3.11. Command: TEXT 

It is possible to introduce text formatted in several ways. The procedure, after opening the format 
dialogue: 

 
...asks for the introduction of two points laying everywhere in the tridimensional space: the A vertex (point 
0 in figure) and the B vertex (point 1 in figure) along the text line: 

 

4.3.12. Other commands 

At the bottom of this menu the user will find the name of the files contained in the "Models" folder inside 
the user Libraries folder, as seen in chapter 2 Getting started. Every ".lcdoc" Brotens document the user 
will put inside the "Models" folder, before starting the application, will be displayed in this menu. 

With these menus it is possible to insert a whole Brotens model inside the active one (except camera 
objects), mainaining layer attributions (new layer will be added to the current drawing if not already 
present in the list). 

Selecting one of these files, the procedure asks for the position of the origin of the model (point 0 in the 
figures), the direction of the local X axis (point 1 in figure) and the direction of the local Y axis (point 2 in 
the figures), like in the following figures, in which the local axis for the model to insert are drawn. 

 
In every moment, during the introduction of those three points needed to assign the position and 
orientation of the model in the space, it is possible to execute a mouse double click: in this case the 
orientation procedure will be stopped, and the model placed following the Active Coordinate System.   

Text 



  Guide 

User Guide © 2014-2023 58 Marcello Brocato and Ecleti - Roberto Panetta 

4.4. Menu Edit 

4.4.1. Command: UNDO 

Permits to revert the last command. This permits to come back in the command sequence. 

4.4.2. Command: REDO 

Permits to discard the effects of the “Undo” command, going on one step in the command sequence. 

4.4.3. Command: INFO 

This command allows the user to set the characteristic parameters of every element. 

The procedure is different whenever it is present or not a selection set built with a single element. 

If no element is selected the user will be able to set the default parameters of the future entities to create. 

If only one element is selected the user can change its parameters, in the same way as through a 
contextual menu procedure. 

4.4.3.1. selection: Flat Surface 

The item opens a dialog in which it is possible to control the characteristic parameters of the flat surfaces: 
if one is selected the user can change its parameters, with no selection the user can assign the default. 
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The dialog presents some field, following the type of surface: 

• if one element is selected, an edit field to renumber the surface (see fig.1: ‘Face No.’); 
• if one element is selected, a field displaying the number of vertex and the area of the surface (see 

fig.1: ‘N=..., A=...’); 
• one pop-up menu for setting the layer to which the element belongs; 
• two edit fields for defining local calculation grids; 
• one button to make the internal grid rectangular: in this case the two 'Grid' edit field refers to the 

X-size and Y-size of the rectangular grid (for ex. EN13201 calculation); 
• one pop-up menu 'Surface' to specify the kind of surface, that may be: 

o real; 
o virtual (side up means that the lighting flows on the local-UCS Z-positive side); 
o virtual (side down means that the lighting flows on the local-UCS Z-negative side); 
o road. 

• one or two pop-up menus for setting colors and reflection coefficients of the element; 
• one button /   that permits to link or not the Color and the Texture’of the 'down' side to the 

one of the 'up' side (if the surface is defined as 'real'); 
• one or two check box to activate the texture mapping on the face sides (if the surface is defined 

as 'real'); 
• one or two pop-up menus for setting the Texture to apply to the ‘down’ and ‘up’ side of the 

element that allow the user to examine the images to be linked (if the surface is defined as 'real'); 
• one or two edit field to set the scale of the textures (if the surface is defined as 'real'); 

In case the 'road' type is selected through the ‘Surface’ pop-up menu, will be enabled: 

• one pop-menu for selecting the layout type; 
• one pop-menu for selecting the road-class; 
• one edit field for defining the central reserve width; 
• two edit fields to define the sidewalks width; 
• one edit field to define the lane width; 
• one edit field to define the number of lanes; 
• one edit field to assign the reduced luminance coefficient q0 is different from the class standard; 

Colors may be chosen through the standard Mac procedure 

while in the dialogue is visible the current color with its number (ex. #248), its reflection coefficient (ex. 
r=72%) and its RGB components in % (ex. RGB { 75, 75, 75} ). 
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Textures will be aligned with the x-axis of the face and will be scaled following the ‘scale’ parameter 
(Scale=1 map the texture on the whole face). 

Finally, please, notice that textures are not involved in calculation, so the user has to match the colors of 
the face sides with each texture, as the fig.1 shows. 
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4.4.3.2. selection: OPENING 

The item opens a dialog in which it is possible to control the characteristic parameters of the openings: if 
one is selected the user can change its parameters, with no selection the user can assign the default. 

 
Are presents: 

• an edit field to renumber the hole (if one is selected: Hole No. ...); 
• a pop-up menu for selecting the type of the opening, that may be: 

o Empty, a simple hole in a wall; 
o Glass, a window type; 
o Opaque, to define in the surface a different color area, that always will follow the internal 

finite element grid; 
o Emissive, to define an emitting surface to simulate, for example, a shop window; 

• an edit field (only "glass" type) for entering the value of the extinction coefficient K [m-1/ft-1] of 
the Bouguer Law, based on the assumption that the radiation absorbed by a glass is proportional 
to its intensity and to the path of the radiation inside the glass L/cosØ, with L=glass thickness: 

Itransmitted

Iincident  = EXPèç
æ

ø÷
ö-

K·L
cosØ   

The K coefficient may vary from approximately 4m-1 (1,22ft-1) for “water white” glass (which appears 
white when viewed on the edge) to approximately 32m-1 (9,75ft-1) for poor (greenish cast of edge) glass; 

• an edit field containing the illuminament in lux of the emitting surface (only "emitting" type), that 
will spread light in Lambertian mode with the assigned color; 

• an edit field for introducing the total thickness of the glass in millimeters (only "glass" type), 
computed without eventual cavities among glasses; 

• a pop-up menu for selecting the color (not present for the "empty" type); 
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Colors may be chosen through the standard Mac procedure 

while in the dialogue is visible the current color with its number (ex. #248), its reflection coefficient (ex. 
r=72%) and its RGB components in % (ex. RGB { 75, 75, 75} ). 

4.4.3.3. selection: LIGHTING SOURCE 

Selecting this item, if the selection contains more than one lighting source the application opens a dialog: 

 
... in which a list of the source is presented, and the user can copy it and modify some parameters; 
double-clicking on the column header the whole column will be modified. 

If only one source is selected the user can choose its characteristics, if no selection is done, the user can 
choose the default source: 
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In the dialog are presents two sections: 

4.4.3.3.1. Catalogue sources section: 

Contains: 

• the list of the codes and the models of the luminaires in the open source catalogue in which, if 
present, is highlighted the selected luminaire; in the bottom of this list a button (with the name of 
the actual catalogue) to open another one; 

• a 'search' edit field, to look for some text in the open catalogue; the dimension of the luminaire 
bounding box and the its luminous volume, that is the spatial encumbrance of the luminous zone 
of the luminaire; 

• the photometry of the active luminaire in the list; 
• the image of the active luminaire in the list. 

The user can copy a specified source name using a contextual menu (‘ctrl’+click on a row). 

4.4.3.3.2. Active Source section: 

Contains: 

• a button 'Get from Catalogue' to load the active luminaire in the list and assign it to the selected 
(or to the default) lighting source ; 

• a 'Copy to group' check box to propagate the choice to the group of the selected source; 
• an edit field “Source n.” that permits to renumber the source in the project. (if a source is 

selected); 
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• a check button (“on”) to include or exclude the source in the calculation; 
• the position (in x,y,z coordinates) and the aiming (in azimuth, zenith values) of the selected 

source (if a source is selected); 
• a 'Model' edit field that contain the name of the selected source (if a source is selected) or the 

name of the active source (if no source are selected); 
• the name of the catalogue of the selected/active source; 
• a pop-up menu to choose the layer to which the source belongs; 
• a button '3D model' to link a DXF model to the selected source. The model to link will have origin 

and orientation according to Illuminando source Coordinate System; 
• two pop-up menus for selecting the colors of the body and group of the lighting source; 
• some edit field containing the total power in Watt installed in the lighting source (that is the sum of 

the power of the lamps, the ballast, ...), the maintenance factor (the cleaning level both of the 
luminaire and of the room in which it is installed: 0 = very dusty ... 100 = very clean), the dimming 
percentage in power (W) and in Lumen (linkable through the lock button); 

• an "Emergency..." button, in witch it is possible to fix the emergency lighting values based on the 
installed ballast, following the next dialogue and formula: 

 

𝐿!"!#$ =	
𝐿%&% ×𝑊'())(*%

𝑊%&% × 𝜀'())(*%
 

• L	=	flux	[lumen];	
• W	=	power	[watt];	
• e	=	efficacy	[0-1].	

This section contains also three sub-sections: 

• Lamp sub-section: contains some fields showing the bulb installed in the lighting source and in 
particular, the number, the type (halogen, fluorescent, ...), the flux in lumen and power in Watt of 
each lamp, the correlated color temperature in Kelvin degrees and/or the color of the same lamp, 
selectable  through the standard Macintosh Color Manager. 

• Blinds, anti-glare grid sub-section: contains four edit field to choose the aiming angles of the side-
shader and one edit field to fix the height of the side-shader and three edit fields to fix the xy-size 
and z-height of an anti-glare frontal grid. ; 

Symmetric flux sub-section: contains three check box to make the source position and aiming symmetric 
along the X, the Y global axis and from the Origin (active only if X and Y symmetry both checked); see 0   
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• Sources symmetry section. 
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4.4.3.4. selection: OBJECT 

Selecting this item, the Application opens a dialog in which the user can choose the object parameters: if 
one is selected the user can change its parameters, with no selection the user can assign the default. 

 
Are present: 

• the edit fields that may vary according to the element selected from the 'Type' pop up menu; 
• one pop-up menu for setting the layer to which the element belongs; 
• one pop-up menu for choosing the 'Surface' type (real or user); 
• one (for user 'Surface' type) or two (for real 'Surface' type) pop-up menus for setting colors and 

reflection coefficients for both the element sides; 
• one button /  to link or not the color and texture of the back side to the one of the front side. 
• one or two check box to activate the texture mapping on the face sides (if the surface is defined 

as 'real'); 
• one or two pop-up menus for setting the Texture to apply to the ‘down’ and ‘up’ side of the 

element that allow the user to examine the images to be linked (if the surface is defined as 'real'); 
• one or two edit field to set the scale of the textures (if the surface is defined as 'real'). 

Textures will be aligned with the x-axis of each finite element of the object and will be scaled 
following the ‘scale’ parameter (Scale=1 map the texture on the whole finite element). 

Finally, please, notice that textures are not involved in calculation, so the user has to match the colors 
of the object sides with each texture, as the figure shows. 
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4.4.3.5. selection: LINE 

Selecting this item, the Application opens a dialog in which the user can choose the lines parameters if 
one is selected the user can change its parameters, with no selection the user can assign the default. 

 
Are present: 

• a field reporting the line number (possible to change) and its length (if a line is selected); 
• a pop-up menu for setting the layer to which the element belongs; 
• a pop-up menu to assign the type of line (simple line, wire, quote or road axis); 
• a pop-up menu for setting the color of the element; 
• a pop-up menu for setting the dash type of the element (not available for 'Quote' type); 
• a pop-up menu for setting the thickness of the element (not available for 'Quote' type). 

Colors may be chosen through the standard Mac procedure 

 
while in the dialogue is visible the current color with its number that assign the element to a group of 
wires. 
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4.4.3.6. selection: POLYLINE 

Selecting this item, the Application opens a dialog in which the user can choose the polylines and polygon 
parameters; if one is selected the user can change its parameters, with no selection the user can assign the 
default. 

The dialogue will change according to the 'Type' pop-menu selection: 

  

  
 

The dialogue presents: 

• a field reporting the line number (possible to change) and its length (if a polyline is selected); 
• a pop-up menu for setting the layer to which the element belongs; 
• a pop-up menu to assign the type of line (simple polyline, wire, arc, source); 
• a pop-up menu for setting the color of the element; 
• a pop-up menu for setting the dash type of the element; 
• a pop-up menu for setting the thickness of the element; 
• if type-arc is selected, four edit fields to set the X and Y radius and the aperture in degrees of the 

enveloping circle and the number of edge to approximate the arc; 
• if type-source is selected the element will be converted into a polyline-source, and a list of lighting 

source that will represent the 'specific' photometry of the linear source (1) will be shown: the user 
will also be able to choose the catalogue from the button under the list, to search a source name, 
to set total power, mainteinance factor, dimming values and color as color temperature or RGB 
with the special fields. 

  

 
1 To use these kind of sources the user have to save the photometry as 'specific', per units of length (meter or inch) 



  Guide 

User Guide © 2014-2023 69 Marcello Brocato and Ecleti - Roberto Panetta 

Colors may be chosen through the standard Mac procedure 

 
while in the dialogue is visible the current color with its number that assign the element to a group of 
wires. 

4.4.3.7. selection: CAMERA 

A dialog is opened in which the user can edit the number, the position and the layer assigned to the 
selected observer: 

 

4.4.3.8. selection: TEXT 

Selecting this item, the Application opens a dialog in which the user can modify the format for the selected 
text object: 

 
The user will be able to edit the string, to choose the height, bold and italic variations, the font, the 
underline type and the layer assigned to the text object. 
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4.4.4. Command: SELECT ALL 

Select all entities in the drawing. 

4.4.5. Command: SELECT SPECIAL... 

Permits to create a new selection set, by choosing the elements to include by its number. The so created 
selection set may be added to an existent set or it is possible to add a new set to the one just created. In 
the filtering selection dialog... 

 
...the selection of numerically contiguous elements goes on by a minus sign ('-'), while selecting 
uncontiguous elements goes on by a comma (',') separation (for example, if the user type '1-3' in the first 
field, and '1,5,8-21' in the third field, the Application will select flat surfaces from 1 to 3 and lighting 
sources 1, 5 and from 8 to 21). 

It is possible to select all the element types checking the relative check-box. 

If a lighting source is selected, it is also possible to select the whole group of sources of the selected one 
activating the relative button. Finally, it is possible to select all elements belonging to a certain layer. 

4.4.6. Command: MOVE 

The command is differently applied where the selected element is an opening or a complex selection set. 
In the latter case all the elements are moved: the Application asks to introduce the initial point of the 
movement that may occur in all directions in the space, it then asks for the final point. 

If the user selects one (and only one) opening, the Application asks to introduce the first and the second 
point of the movement that can only be inside the boundary. 

In the status line, the Application will prompt the user about the procedure to execute in the command. 

4.4.7. Command: RESHAPE 

The command is applied on a single selection in different modes following the selection of the element. 

4.4.7.1. Flat Surface 

Selecting the menu, the Application automatically brings the actual reference system onto the surface 
plane. It is possible to move a vertex simply by clicking on an existing one and moving it to a new 
position, which will be automatically projected onto the local XY of the same surface. 
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To add a new vertex just click on an edge of the surface and assign the position of the new vertex, which 
will automatically be projected onto the local XY of the same surface. 

4.4.7.2. Opening 

Selecting the menu the Application automatically brings the Actual Coordinate System onto the surface 
plan to which the opening belongs; It is possible to move a vertex inside the boundary of the owner flat 
surface simply by clicking onto an existing one and moving it to a new position, which will automatically 
be projected onto the Local XY plane of the same surface. 

To add a new vertex just click onto an edge of the surface and assign the position of the new vertex inside 
the boundary of the owner flat surface, which will be automatically projected onto the Local XY plane of 
the same surface. 

4.4.7.3. Lighting Source 

For a standard source (not a polyline-source) it is possible to reassign: 

• the position of the body; 
• the pointing direction; 
• the direction of the frontal axis; 

...of the lighting source. 

The procedure is identical for the three cases: it is enough to select the point to be modified and reassign 
the new position, controlling that the three points a), b) and c) after modification, will not be aligned. 

For a polyline-source it is possible to reassign: 

• the pointing of each segment: the user has to select the pointing to be modified and reassign the 
new position that will be adjusted by the Application to make it perpendicular to the segment; 

• the shape of the polyline: the user has to convert the polyline-source in a simple polyline or arc, 
edit and it convert it again in a polyline-source. 

4.4.7.4. Line 

It is possible to move a vertex simply by clicking on an existing one and moving it to a new position. 

4.4.7.5. Polyline 

It is possible to move a vertex simply by clicking on an existing one and moving it to a new position. 

To add a new vertex just click on an edge of the surface and assign the position of the new vertex. 

4.4.7.6. Text 

It is possible to move a vertex simply by clicking on an existing one and moving it to a new position. 
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4.4.8. Command: EXTRUSION.../EXTRUDE 

If no selection is present the Command permits to define the default extrusion parameters, while if the user 
has made a selection containing some lines, polylines, flat surfaces and openings the application will 
apply the command on them. 

 
The openings will be extruded in the Local Coordinate System of the owner surface, while other elements 
will be extruded in the Active Coordinate System, following the selected parameters in the appropriate 
dialog on the right. 

For the flat selected surfaces it is possible also to build the closing top faces including or not their holes. 

4.4.9. Command: DELETE 

Allows eliminating all the objects contained in the actual selection set. 

4.4.10. Command: DUPLICATE 

Allows creating a copy of all the objects contained in the actual selection set. 

The Application asks to assign the origin point for duplication and the destination point for copying the 
group. 

In the status line, the Application will prompt the user about the procedure to execute in the command. 

4.4.11. Command: ROTATE 

Allows rotating all of the objects contained in the actual selection set, creating, eventually, a copy 
following the next dialog: 

 
In the status line, the Application will prompt the user about the procedure to execute in the command. 

The rotation mode, with or without copy, will be of four types. 

4.4.11.1. Rotation relative 

Selecting one of the three buttons 'X local', 'Y local' or 'Z local' each element will rotate of the edited 
value along each local axis. 
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4.4.11.2. Rotation absolute 

Just assign an angle rotation 'A' in the edit field, and the objects will be rotated by 'A', following the Z 
axis normal to the Active Coordinate System (red), whose XY plane is the rotation plane. 

 

4.4.11.3. Rotation by three points 

The Application asks to assign firstly the origin of the Z axis, normal to the rotation plane (point 0 in the 
figure), then the direction of the axis which will be the origin of rotation, (point 1 in the figure), and finally 
the final direction of rotation (point 2 in the figure), which, projected onto the rotation plane, describes the 
total angle of rotation. 

 

4.4.11.4. Rotation by three points with fixed angle 

The procedure is identical to that by three points, except for the fact that total rotation "A" is assigned in 
the edit field. 

 

4.4.12. Command: MIRROR 

 
Allows mirroring, with eventual copy, all of the objects of the selection set, respective to the XY plane of a 
Coordinate System defined by three points, as follows: 

• the first point (point 0 in the figure) is the origin of the Temporary Coordinate System; 
• the second point (point 1 in the figure) denotes the x axis of the mirror; 
• the third point (point 2 in the figure) defines the normal y at the xz-plane of the mirror. 
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In the status line, the Application will prompt the user about the procedure to execute in the command. 

4.4.13. Command: SCALE 

Allows to scale, eventually copying, the selection set in percent at the actual dimensions; the Application 
asks for the point origin of the scale procedure, if the relative button is checked, otherwise the scaling will 
proceed for the origin of each selected element. The 'proportional' button permits an uniform scaling. 

 
In the status line, the Application will prompt the user about the procedure to execute in the command. 

4.4.14. Command: TRIM/EXTEND 

The command permits: 

• selecting two lines: to cut or extend them. 
• selecting one lines: to trim/extend lines or the external segment of the polylines. The procedure to 

trim lines and polylines is the following: 
1. select the line or the face on which cutting or extending (the menu highlight); 
2. choose the menu 'Modify' -> 'Trim/Extend'; 
3. select the end of the line to cut or to extend. ; 
4. select the end of the line to cut or to extend; 
5. ... 

 
• to trim faces to faces: the procedure is the following: 

1. select the face on which cutting or extending (the menu highlight); 
2. choose the menu 'Modify' -> 'Trim/Extend'; 
3. select the end of the line or the edge of the face (near the vertex to move) to cut or to extend ; 
4. select the end of the line or the edge of the face (near the vertex to move) to cut or to extend; 
5. ... 
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In gray the trimmer surface: the selected vertex will be moved along the edge on the dashed line 
that represent the intersection of the two faces. Autointersections are controlled. 

• to build the 'under-roof' walls: the procedure is the following: 
1. build the under-roof walls with two consecutive points coincident to the 'foot-points' of the 

object; 
2. select the object and the walls to extend; 
3. select the 'Trim/Extend' command from the menu. 

 
• to trim/extend lines, polylines or edge of flat surfaces on object. An example on the next figure 

containing the click sequence (1 = trimming object) and the effects on a line (2), the edge of a flat 
surface (3) and a source aiming (4): 

 

4.4.15. Command: OFFSET 

Permits the creation of a parallel-copy of a flat surface, a line or a flat polyline. 

The Application ask for an offset distance, positive if the original surface will be enlarged: 
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The button 'duplicate' if checked permits to leave the original surface and copy the offset one. 

  

4.4.16. Command: EXPLODE 

Permits to convert: 

• objects into flat surfaces; 
• flat surfaces into polylines; 
• polylines into single lines. 

Select the objects to explode and run the command. 

4.4.17. Command: JOIN 

Following the selection: 

• if two flat surfaces are selected, the command permits to transform the one contained in the other 
to an hole, empty if the color of the original face is 255, or opaque of the same color of the 
original face in the other case: 

 
• if faces are not contained une in the other, or selecting more than two faces a new object will be 

created: the faces will be the Finite Elements of the new object on condition that the face have less 
than 4 points, otherwise the face wil be not added. 

• if only one line is selected, it will be converted in a 3-points polyline, adding the original line 
middle point; 

• if are selected line and/or polylines, the command permits to join more connected lines between 
them or to an existing and selected polyline: 

 
The user must start from two connected lines or from a polyline and some lines. Selecting only one 
planar polyline, the next command 'Join' will create a flat surface. 

• Selecting two or more objects it is possible to create e new object given by the sum of all the finite 
elements: the new object wil be no more parametric. The new Finite Elements will keep the color 
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of the original object: to discard these colors it is possible to select the command 4.4.21.1.3 Finite 
Elements Reset. 

4.4.18. Sub-menu: ARRAY 

From this menu, it is possible to make multiple copy of a selection set. 

4.4.18.1. Command: RECTANGULAR 

In the actual Coordinate System, a rectangular array of 'Rows Number' x 'Column Number' will be 
executed at regular intervals. 

 
Checking the '...by Points' box the user will be able to define with 3 mouse clicks (0, 1 and 2 in the next 
figure) the direction of the array and the total distances, following the drawing: 

 
In this case the 'Total X-distance' will be divided for the 'Column Number' value, and the 'Total Y-distance' 
will be divided for the 'Row Number' value to obtain the array steps. If the box '...by Points' is no checked 
the distances between rows and between columns will be assigned from the fields 'Rows Distance' and 
'Columns Distance' according to the following scheme: 

 

In this case rows direction will be that one of the local X-axis. 

• Rd = row direction; 
• Rs = row step distance; 
• Cd = column direction; 
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• Cs = column step distance. 

The 'Insert last' check-box permits to add or not the last row and column. 

4.4.18.2. Command: POLAR 

In the actual Coordinate System, a polar array will be executed at regular angle intervals, eventually with 
a vertical translation relative to the rotation plan. 

 
Once filled the fields, choosing 'Ok' the Application will execute the polar array relative to the actual 
Coordinate System, while choosing the button '3 points…' the copy will be executed relative to a 
temporary Coordinate System that the user will assign by three points: the Application asks the position of 
the new origin (point 0 in figure), the direction of the new local X axis (point 1 in figure) and the side of 
the positive Y semi plan (point 2 in figure): 

 
The procedure will follow the next scheme (A = angular step, dZ = elevation step): 

 

4.4.19. Command: DIVIDE 

Is useful to divide the selected lines in so many parts how much indicated in the edit field: 

 

4.4.20. Command: RANDOMIZE COLORS 

Selecting faces and/or objects, with this command it is possible to automatically assign them a random 
color (useful to customize book in a library, dresses in a stand...). 
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4.4.21. Command: OTHER... 

4.4.21.1. FACES: 

4.4.21.1.1. Command: RECTANGULARIZE... 

Permits to reshape the selected face as a rectangular one, of width and height given through the following 
dialogue: 

 
...and the 'width' direction following the local X-axis. 

4.4.21.1.2. Command: SET GRID 

Permits to divide the selected surface in a fixed number of finite elements, determining the rectangular 
dimension of each of them as the ratio [surface X-size]/[n.of elememts along X-axis] and [surface Y-
size]/[n.of elememts along Y-axis] 

 

4.4.21.1.3. Command: AIMING SURFACE 

Selecting one flat surface, this will be used as a trimming/extending surface for all the light source 
pointing. 

4.4.21.2. SOURCES: 

4.4.21.2.1. Command: SYMBOL TO SOURCE 

Selecting a symbol imported from a DXF file, is possible to insert for each instances of that symbol a 
luminous source, with the options defined by the following dialogue: 



  Guide 

User Guide © 2014-2023 80 Marcello Brocato and Ecleti - Roberto Panetta 

 
...in which it is possible: 

• to open another source catalogue (button under the list 'n./Model'); 
• to select the lighting source from the active catalogue (list 'n./Model'); 
• to search for a specific model in the list ('Search' edit field); 
• to set layer in which all the sources will be insert (pop-menu 'Layer'); 
• to set the common group for all the sources to insert through the color box or the edit field 

('Group color'); 
• to set the common height for all the sources to insert (edit field 'Height'); 
• to set the pointing-ax rotation for all the lighting sources to insert (edit field 'Rotation'); 
• to delete all symbols at the end of the procedure; 
• to add a pole for each fixture. 

4.4.21.2.2. Command: CHECK OVERLAPPING 

The comman is useful to find doubled lighting sources (sources with the same position and pointing) to 
avoid calculation error. In case of doubled sources the application prompt: 

 
...and select the doubled elements. 

4.4.21.2.3. Command: RESET AIMING 

This command permits to reset pointing to global negative Z-axis and pointing rotation to global positive 
X-axis, following the next figure: 
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4.4.21.2.4. Command: VERTICALIZE X-AXIS 

Permits to reshape in vertical the x-axis of the selected sources, following the next figures: 

Before the command… 

 

After the command… 

 

4.4.21.2.5. Command: RESET DIMMING 

Permits to reset to 100% both the W and Lm dimming of the selected sources. 

4.4.21.2.6. Command: MOVE SOURCE ORIGIN 

This command permits to make relative displacements of the source position, whitout changing aiming 
point and x-axis direction of it: 

 
  

X
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x
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X
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x
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4.4.21.1. OBJECTS: 

4.4.21.1.1. Finite Element Info 

This command is active once the user has selected an object: it permits to modify the characteristics of 
some finite element of this object. Selecting the object and then the command, the application ask to pick 
the finite element to modify: 

 
Picking follows the standard procedure: simple-click select the first Finite Element, ⇧(shift)-click permits to 
highlight one by one all elements founded under the click. Once presented the right one a simple-click 
permits to confirm it as selection, and the Finite Element Info dialogue opens displaying: 

...the parameters as the object default (box checked) ...the parameters to assign (box unchecked) 

  
It is possible to transform the selected Finite Element in a hole with all its characteristics (see 4.4.3.2 
selection: OPENING) and to copy'the selected parameters (button 'Copy') for pasting them to other Finite 
Elements to select later (button 'Paste'). The application continue asking for another Finite Element: to end 
the command the user has to press the 'ESC' key. 

If the Scele Kit window (see § 3.2 Scene Kit window) is opened it will be updated following this dialogue. 
WARNING: all modification will be lost modifying the object parameters or changing the calculation 
resolution (from the 'High resolution' command). 

4.4.21.1.2. Finite Element Invert Normal 

This command is active once the user has selected an object: it permits to invert the orientation of some 
finite element of this object. Selecting the object and then the command, the application ask to pick the 
finite element to invert its normal: 
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Picking follows the standard procedure: simple-click select the first Finite Element, ⇧(shift)-click permits to 
highlight one by one all elements founded under the click. Once presented the right one a simple-click 
permits to confirm it as selection and the application display in the command line its internal number and 
continue asking for another Finite Element: to end the command the user has to press the 'ESC' key. 

If the Scele Kit window (see § 3.2 Scene Kit window) is opened it will be updated following this dialogue. 

4.4.21.1.3. Finite Elements Reset 

Permits to discard all the particular characteristics previous saved through the 4.4.21.1.1 Finite Element 
Info paragraph for the single finite element in the selected object. 

4.4.21.2. ALL ELEMENTS: 

4.4.21.2.1. Command: ASSIGN AS DEFAULT 

Assign the parameters of selected element as default. 

4.4.21.2.2. Command: ASSIGN TO CURRENT LAYER 

Assign to the current layer the selected elements. 

4.4.22. Command: CUT 

Works only in the selected edit field, in the standard Macintosh mode. 

4.4.23. Command: COPY 

If an edit-field is selected the command works in the standard Macintosh mode. 

With the main view actived (by clicking on it, no edit field selected) the procedure is different if there is 
present or not a selection set: 

• if no element has been selected the content of the view will be inserted into the clipboard in PDF: 
this allows to transfer information between Brotens software and the other programs; 

• if one element is selected, the application will copy into the clipboard the element parameters 
enabling to transfer them through the paste command applied to a selection set; 
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• if more than one element is selected, they will be copied into the clipboard for pasting them 
afterward. 

4.4.24. Command: PASTE 

If the clipbord contains parameter to transfer (see previous paragraph) the command permits to transfer 
those parameters flagged in the 'Paste Special' dialog from a source-element to a destination-selection set.  

The destination group may be also formed by objects of different type than the source-element: the 
Application recognizes the attributes to paste among heterogeneous elements (example: colors among 
flat surfaces, objects, lines and lighting sources) and permits to transfer them. 

If the clipboard contains Brotens elements from a previous 'copy' command, they will be inserted in the 
model in the active User Coordinate System. 

4.4.25. Command: PASTE SPECIAL... 

The Application permits to choose data to transfer before pasting them to the selection set (see the figure): 

 
A dialog is shown, in which the user will be able to select those parameters to transfer in the next paste 
operation. 

Checking the relative button, the Application will remember to 'paste' to the destination-set the selected 
parameter. 

Two other buttons permit to select or unselect all check boxes. 
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4.5. Menu Coordinate 
The menu permits to enter the Active Coordinate System modification section. The triad of the Global 
Coordinate System is always visible in green color: if the Active System is the Global one, the “Global” 
item will be marked with “√”; if the Active System is a Local Coordinate System of an element in the 
scene, the “Local” item will be marked; in the other cases both the menus will be unmarked. 

4.5.1. Command: LOCAL 

For a selection set built with a single element of type Plan, Opening, Lighting source or Object, it is 
possible to attach the Active Coordinate System to the local one of the selected element. Switching from 
the Global System to a Local System is highlighted by a mark “√” in the menu and by the presence of the 
red triad in the visualized space. 

4.5.2. Command: GLOBAL 

It is always possible to make the Active one the Global Coordinate System; the Application puts a mark 
“√” in this menu item and eliminates the red triad from the video. 

4.5.3. Command: LOCAL ON THE FLY 

Permits to switch from the active to another Local Coordinate System of the element pointed my the 
mouse, without selecting it. The command is useful, for example, to switch to another Coordinate System 
while aiming a source. 

4.5.4. Command: MODIFY 

The command may be used in two different modes, in the case where there is active a Local Coordinate 
System of a Flat Surface or not. 

4.5.4.1. Is active the Local System of a Flat Surface 

This is case in which a single element is selected end the user chooses the command “User” from the menu 
“Coordinates”. 

The Application presents a dialog for modifying the Local Coordinate System of the element, in which it is 
possible to rotate end eventually to move the System only on the plan of the same Surface: 

 
For a Flat surface the System may be: 

• rotated on a generic angle around the Z axis of the local Coordinate System (or Systems); 
• rotated 180° around the local X axis (inverting the positive semi-space viewed from the surface); 
• rotated 180° around the local Y axis (inverting the positive semi-space viewed from the surface). 
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In this last case the Application asks the position of the new origin (point 0 in figure), the direction of the 
new local X axis (point 1 in figure) and the side of the positive Y semi plan (point 2 in figure): 

 
In every moment, during the introduction of the three points needed to assign the position and orientation 
of the new Coordinate System in the space, it is possible to execute a mouse double click: in this case the 
orientation procedure will be stopped, and the new Coordinate System is simply translated to the first 
introduced point. 

4.5.4.2. Is active a generic Coordinate System 

The Application presents a dialog to modify the Active Coordinate System: 

 
The System may be: 

• rotated on a generic angle around a generic axis; 

In the last case, the Application asks for the position of the new origin, the direction of the new X axis and 
the side of the semi plan of the positive Y, similar to the previous paragraph. 

4.5.5. Command: BY 3 POINTS... 

Permits to reach quickly the procedure to reassign the Coordinate System by three points: the Application 
asks the position of the new origin (point 0 in figure), the direction of the new local X axis (point 1 in 
figure) and the side of the positive Y semi plan (point 2 in figure): 

 

4.5.6. Command: ROTATE X 

Permits to reach quickly the procedure to rotate of 180° along the X-axis of the Coordinate System; if it is 
active the Local Coordinate System of a face or a polyline-source, the rotation will be of 90°. Pressing 
⌥(option) key while choosing the command the rotation will be done in the opposite side. 
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4.5.7. Command: ROTATE Y 

Permits to reach quickly the procedure to rotate of 180°along the Y-axis of the Coordinate System; if it is 
active the Local Coordinate System of a face, the rotation will be of 90°. Pressing ⌥(option) key while 
choosing the command the rotation will be done in the opposite side. 

4.5.8. Command: ROTATE Z 

Permits to reach quickly the procedure to rotate along Z-axis the Coordinate System (also for the Local 
Coordinate System of a face) that will always be of 90°. Pressing ⌥(option) key while choosing the 
command the rotation will be done in the opposite side. 

4.5.9. Command: ASSIGN NEW ORIGIN 

The command works differently if some flat surfaces are selected or not: in the first case the software will 
automatically move the origin of the selected faces each in the barycenter of their points, otherwise the 
user will be prompted to introduce a point that will be the new global origin. 
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4.6. Menu Options 

4.6.1. Command: COLORS 

Colors, always based on 256 tones, are presented in a palette like the following one: 

 
in which is visible the original color (blue framed) and the active color (black framed) with its number (ex. 
#80), its reflection coefficient (ex. r=62%) and its RGB components in % (ex. RGB { 60, 79, 79 } ). 

The 'other' field permits to assign the color through the standard Mac dialogue. If there is a selection set, 
choosing a color from the palette the user will assign that color to all the object of the selection to both the 
side of the surface. Sources will be assigned to the relative color group. Without selection it is possible to 
assign the color for the background of the window. 

4.6.2. Command: PLACE... 

This command assigns the place and the hour of the lighting simulation through a dialog: 

 
Selecting the reference city, the Application suggests the latitude and the direct and diffuse radiation on 
an horizontal plane: all of these values may be modified once the 'Custom Place' box will be checked. 

Other parameters assigned are the month, the day and the hour of the simulation and the albedo 
(medium reflectivity of the external ambient). Introducing the values, the user will be able to check the Sun 
position in the sky: the Application will update the polar diagram near the button with the new position. 
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4.6.3. Command: EDIT PLACES... 

The command opens the 'cities' database, a text file with tabulations. The Application simulates the 
radiation function as symmetrical curves, being the hour 12:00 on the symmetry axis: to explain, radiation 
at 11:00 ‘o clock is equal to 13:00, that one at 10:00 ‘o clock is equal to 14:00, and so on: 

city #1 name 

city #1 latitude 

January 

Idirect(h12:00) Idirect(h13:00) Idirect(h14:00) Idirect(h15:00) ... Idirect(h ##:##) 

Idiffuse(h12:00) Idiffuse(h13:00) Idiffuse(h14:00) Idiffuse(h15:00) ... Idiffuse(h ##:##) 

February 

...      

city #2 name 

city #2 latitude 

... 

 For every cities it is necessary to input the following fields, where with Idirect(h ##:##) e Idiffuse(h ##:##) are 
indicated the direct and diffuse radiation [W/m2] on the horizontal plane at hour x. 

4.6.4. Command: HIGH RESOLUTION 

The command permits the regeneration of the whole project alternatively with large and small grids for 
every element. The "High Resolution" mode is highlighted in the menu item. The Application informs, 
before to confirm the operation, that may be onerous in terms of calculation timing. 

4.6.5. Command: REMOVE UNUSED POINTS 

The Application executes an internal database check, deleting redundant information and entities. 

4.6.6. Command: OPTIMIZE WIRES 

This procedure permits to optimize cable length, if in the project are present lines or polylines defined as 
wires. 

Optimization is based on the standard cable lengths saved in the 'Wires.txt' file described in the 5.11 
Appendix D: "Wires.txt" file structure. 

Using the color field as a group in the line/polyline info dialogue: 
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the user can choose the reel assignement for each wire, then selecting the command the application 
presents the wires optimization dialogue: 

 
Modifying the values in the 'Group' column and pressing 'return' the user is able to examine the actual 
wires-cutting optimization. 

4.6.7. Command: UNI 11248 - EN 13201 ROAD CLASSIFICATION 

Selecting this command the applicatione present the UNI 11248 - EN 13201 tables: 

 
...and it is possible to 'Search' for a text (typing 'return' the application find the next recurrence of the 
inserted string), to 'Copy' the document as an RTF source or 'Save' it in RTF. 

4.6.8. Command: UNI EN12464 WORKING PLACES 

Selecting this command the applicatione present the UNI EN 12464 tables: 
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...and it is possible to copy the document as an RTF source or save it in RTF. 

4.6.9. Command: UNI EN12464-2 2014 OUTDOOR WORKING PLACES 

Selecting this command the applicatione present the UNI EN 12464-2 2014 tables: 

 
...and it is possible to copy the document as an RTF source or save it in RTF. 

4.6.10. Command: UNI EN12193 & SPORT 

Selecting this command the applicatione present the UNI EN 12193 and other rules tables: 

 
...and it is possible to copy the document as an RTF source or save it in RTF. 
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4.6.1. Command: CONVERSIONS 

EasyLighting presents in the third tab of the window a tool that permits to resolve some lightig conversion: 
the use is trivial, and are present both direct and inverse solutions: 

 
Symbols in the following paragraphs are relative to: 

E ....................................................................................................................................... Illuminament 

Ø .................................................................................................................................................. Flux 

I .............................................................................................................................................. Intensity 

P ................................................................................................................................................ Power 

h .............................................................................................................................. Luminous Efficency 

A .................................................................................................................................................. Area 

D ............................................................................................................................................. Distance 

4.6.1.1. Flux ⇒ Illuminament 

𝐸 =	
Ø
𝐴 

4.6.1.2. Illuminament ⇒ Flux 

Ø = 𝐸 · 𝐴 

4.6.1.3. Flux ⇒ Power 

𝑃 =	
Ø
𝜂 
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4.6.1.4. Power ⇒ Flux 

Ø = 𝜂 · 𝑃 

4.6.1.5. Intensity ⇒ Illuminament 

𝐸 =	
𝐼
𝐷! 

4.6.1.6. Illuminament ⇒ Intensity 

𝐼 = 	𝐸 · 𝐷! 

4.6.1.7. Illuminament ⇒ Power 

𝑃 =	
𝐸 · 𝐴
𝜂  

4.6.1.8. Power ⇒ Illuminament 

𝐸 =	
𝑃 · 𝜂
𝐴  

4.6.1.9. Illuminament conversion 

The application allow to convert illuminament values from the actual units to other units. 

4.6.1.10. Luminance conversion 

The application allow to convert luminance values from the actual units to other units. 
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4.7. Menu Layers 
From this menu the user can show/hide or make active layers (virtual spaces in which elements are 
drawn). Layers are a powerful working tool, because they can simplify the scene, temporarily hiding 
unimportant parts, deleting whole groups of objects and allowing the user to include or exclude from the 
calculation other objects. 

To make a layer the active one simply select it in the menu list, while to show or hide a single layer the 
user has to select the item while holding down the ⌥(option) key. 

4.7.1. Command: SETTINGS... 

Permits to manage layers: 

 
It is possible: 

• to add a new layer (button ); 
• to delete selected layers (button ): the user will be prompted to delete all the elements 

contained in these layers; 
• to bring layer upward in the list (button ); 
• to bring layer downward in the list (button ); 
• to show the selected layers (button ): the layer will be flagged with a '-' sign; 
• to hide the selected layers (button ): the layer will be unflagged; 
• to make the active one the selected layer (button ): the layer will be flagged with a '√' sign; 
• to select all layers whose name contains the text edited in the search field. 
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4.8. Menu View 

4.8.1. Command: RENDERING 

Will be opened a new window for the current document in SceneKit mode: the way to navigate within the 
model is different than the 'normal' mode, and it is called the 'virtual sphere' mode. 

The alternate selection of the command marks with '√' and unmark the item. 

For the management of this window refer to § 3.2Scene Kit window Scene Kit window. 
. 

4.8.2. Command: VIEW SETTINGS... 

The command opens a dialogue that allows the user to modify some parameters of the active document 
and eventually saving them as default (button 'Default for new documents): it is divided into four tabs:. 

4.8.2.1. Visualization section 

The section permits to manage some general parameter of the document: 

 
• to view the scene in black and white mode or in black-red-white mode; 
• to select the text height in the screen; 
• to select the background color; 
• in plan view, to show sources pointing coordinates or angles or none; 
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• in plan view, for those source with no zenital tilt, to stretch their X-axis to a fixed length; 
• to work in auto-snap to known points in creating or modifying element sessions; 
• to show the line barycenter, for an easy snap to them; 
• to project in 2D view also the shut-off lighting sources; 
• to show the finite-element frames in the 2D views; 
• to simplify sources shape as a circle for faster navigation; 
• to draw the real shape of the fixtures (if thay are linked to a 3D dxf file); 
• to show the Sun position (in scale). 
• to enumerate elements, points,... 
• to choose the thickness of the line with which Illuminando renders the scene; 
• to define the virtual grid color, divisions, limits and visualization. 

4.8.2.2. 3D Space section 

The section permits the setting of the tridimensional visualization parameters: 

 
• values and steps for every movement of the view (rotations, zoom, camera, scroll); 
• switch between assonometric /perspective view. 
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4.8.2.3. Sources symmetry section 

This section permits to manage sources symmetry options: 

  
and in particular: 

• Nine fields are present, that permit to translate in an independent way the X-symmetrized sources, 
the Y-symmetrized source and the XY-symmetrized ones; 

• A field that permits to shift the simmetrical source pointing as a percentage of its relative position: 
for example, following the next image: 

 
… the X-coordinate of the pointing of the X-symmetrical source will be shifted of -250cm from the 
standard X-symmetrical position. 

the 'Rotational symmetry' is useful to force the y-axis rotation (better configuration for road project) in the 
symmetric source option: its flag handle the scene according the following scheme (see 0   
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• Sources symmetry section): 

X-X and Y-Y standard symmetry: X-X and Y-Y "rotational" symmetry: 

  

• The ‘Show symmetric source aiming’ permits to semplificate the view: in case of large number of 
symmetrical fixtures their aiming vectors may be obscured. 

4.8.2.4. Info Section 

The section permits to assign the general info for the document: 

 

4.8.3. Command: PLAN VIEW 

This command allows you to project all selected elements in the Local Coordinate System of the first-
selected element (flat surface or object). In a quoted plan view will be visible on the 1st selected element 
L.C.S., for the each selected elements: 

• for each flat surface: its planar projection; 
• for each object: its planar projection; 
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• for each lighting source: its progressive number, a letter for model reference and the pointing 
vector; 

• for each line and polyline: its progressive number and a number for color/group reference; 
• for each camera: its position. 
• with a [Basket object + symmetrized sources] selection the application will ask what simmetrization 

has to be presented: 

 
The alternate selection of the command marks with "√" and unmark the item. 

4.8.4. Command: OTHER SIDE VIEW 

Only in 2D view, permits to invert the side of the 2D projection: this means the back-side of the flat surface 
and the 'internal' side of the object. 

The alternate selection of the command marks with “√” and unmark the item. 

4.8.5. Command: ROTATED VIEW 

Only in 2D view, permits to rotate of the 2D projection. 

The alternate selection of the command marks with “√” and unmark the item. 

4.8.6. Command: BLACK & WHITE 

Permits to switch from a color representation to a black and white (or black, red and white, following the 
relative Preference in the dialog setting) one and vice-versa. This selection checks with a “√” or uncheck 
the menu. 

4.8.7. Command: ZOOM IN 

The command executes one-step zoom in; the step is fixed in the '3D Space section' dialog, at the item 
'steps' as the button 'Zoom in' of the 'View' palette does. 

4.8.8. Command: ZOOM OUT 

The command executes one-step zoom out; the step is fixed in the '3D Space section' dialog, at the item 
'steps', at the item 'steps' as the button 'Zoom out' of the 'View' palette does. 

4.8.9. Command: ZOOM WINDOW 

Through the procedure click-click it is possible to create a rectangle that will point to the area to zoom in, 
as happens with the button 'Zoom window'. 

4.8.10. Command: CENTER VIEW 

Is useful to center the view, as happens with the button 'Center View'. 
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4.8.11. Command: ZOOM SCALE 

This menu permits to bring the actual plan view to one of the selectable values. 

4.8.12. Sub-Menu: VIEWS 

4.8.12.1. Command SETTINGS 

Trough these command the Application enters the view manager: 

 
The dialogue permits: 

• to create a new view (button ); 
• to delete some previously saved view (it is not possible to delete the first seven ones, button ) ; 
• to rename existing view, editing it directly in the table. 

The dialogue presents the name of every saved view in the last part of the list, and it is possible to make 
one of them active simply choosing it in the list. 

4.8.12.2. Other Command 

It is possible to select directly some predefined views (Top, South, West, Bottom, North, East) or others 
previously saved. Selecting one of the saved view through its menus with the ⌥(option) key pressed 
permits to reassign the active view to the saved one. 

4.8.12.3. Command: SAVE IMAGE FOR... 

Permits to save the actual scene for the three types of view: 

• Cover Design (3D scene) 
• Layout design (2D projection scene) 
• Result Design (examine result scene) 
• Rendering (if the OpenGL scene is opened and frontmost) 

...to export in the eventual rtf report (see 4.2.18.1 Export TEXT, RTF format). 

4.8.12.4. Command: COPY VIEW 

The command permits to save the perspective view parameters (scene rotation, point of view placement, 
zoom and frontal section) for a following operation of view restoring through the command “Paste view”. 
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4.8.12.5. Command: PASTE VIEW 

The command permits to restore the perspective view parameters (scene rotation, point of view 
placement, zoom and frontal section) previously saved through the command “Copy view”. 

4.9. Menu Lighting 
This section includes the necessary operations for lighting calculation and for the analysis of results. The 
analysis will be available only for the visible objects on the screen; in other words, there will be excluded 
from calculation those elements belonging to hidden layers. 

4.9.1. Command: CALCUL 

The Application shows a dialog: when the calculation has been started for the first time, it is possible to 
choose sources to include and some other useful parameters for a right analysis. 

There are two different possibilities: if it is the first time that the calculation goes on (left side dialog) or if 
the procedure has been initialized (right side dialog): 

  
The Application gives information on the state of the calculation procedure (computed only Direct, nth 
multiple reflection, ...). 

For still not initialized calculation, the Application asks what to include, and in particular: 

• Sun direct will be computed; 
• Sky model, that may be CIE-model or Mediterranean-model; 
• Sky at low, medium or high precision (in exclusion with the button “Openings”): this option must 

be selected in the case where the user has to execute diffuse lighting calculation on models not 
completely closed with surfaces or for where it will be interested in lighting distribution also on the 
external faces (example: stadium, rooms with windows and very reflective surfaces outside, ...). 
The precision in calculation is affected by the number of divisions of the sky vault with which the 
Application builds the integrals, that are, in the order 25, 49 or 145 points; 

• Openings (in exclusion with the button “Sky”): the button is active only if openings are present in 
the project: the calculation will include only the integrals on transparent surfaces, computed at the 
precision given at the appropriate flat surface internal grid; 

• Sources at low, medium or high precision: artificial lighting sources will be computed. The 
precision in calculation involves the volumetric schematization adopted for the sources: low = 
point light, medium = steps of 40 cm distributed luminance, high = steps of 20 cm distributed 
luminance. 

Calculation will go on, moreover, for the number of total reflections given in the edit field 'Reflection 
number'. For example, to initiate the calculation with direct only '0' must be keyed to initiate the 
calculation with the direct and one multiple reflection 1 or more must be keyed. After the direct 
calculation, inside every group of multiple reflection the user ask to execute, to accelerate them (against 
some precision loss), it is possible to set a 'Minimum luminance' threshold, below which the relative source-
finite element will not be considered. To have an idea of the number of finite elements that will be 
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excluded changing this threshold, it is possible to enter, through the button 'Analyze', a dialogue in which 
these control parameters are presented. 
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Following graphics reporting the number of elements involved (x-axis) in calculation in function of a 
luminance threshold in the first and in the third multiple reflection. 

  
Once the calculation started, the following the dialog: ... 

 
permits to break it by clicking the 'Stop' button or by typing the 'esc' key: after the user reply to confirm 
breaking the calculation... 

 
the Application stops it. To start again from the direct, in whatever step of calculation, it is possible to 
check the 'Return to direct calculation' box. Finally with the 'Calculation without shadows' check box the 
user is allowed to execute very fast calculation, but without computing shadows: turning on this feature 
may bring to high approximations, so a reasonable use is suggested. 
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4.9.2. Command: RESULTS 

After selecting only one element, this command lets you enter 
a section for calculation testing. The drawer changes the 
layout: it is divided into two tabs, as shown on the right. 

The 'Setting' tab permits to assign parameters, while the 
'Results' tab permits to examine and edit the results (an 
example is presented). For the explanation of the available 
options see 4.9.4 Command: RESULT SETTINGS. 
In the main view the user may open a 'zone' with a mouse 
click-drag-release procedure: 

 

 
 

Once the area (in the figure, the red rectangle) is drawn a list of values appear in the drawer at the 
'results' tab, reporting the illuminaments, uniformities, luminances,... of the selected zone: the user can 
copy them. This will take place in different ways, depending on the type of the chosen element: if this is a 
flat surface, it is possible to select also other elements to project on the plan of the surface. At this point 
the clipboard will be automatically filled with the presented text results, in a minimal format if the user 
selected this option in the Preferences. 

Selecting a single 'table' or 'box with shelves' object the dragging operation will display the average 
illuminament on the table surface or the average, minimum and maximum illuminaments on the box 
horizontal shelves. 

Results may be examined in color mapping, in iso-value curves, in numeric values or in mixed mode. 

Inside this section, unusable menus, rotation and camera buttons 
and section scroll bar will be hidden. 

A particular case is the U.G.R. or G.R. plot choice: 

• selecting the curve mapping (see the side image) the 
application will present a star-shaped plot in which each 
segment is proportional to the U.G.R./G.R. value in that 
direction (from the local x-axis at 45° steps). 
Furthermore, the value of the maximum and a circle 
representing the average U.G.R./G.R. in that point are 
plotted; 

• selecting the value mapping the average U.G.R./G.R. in 
that point will be plotted. 

 

 

 

19 19 18 19 20

19 19 16 18 20

19 18 17 17 19

19 18 17 17 19

20 19 18 18 19

Y
X

0

50

100

150

-50

-100

-150

0 50

100

150

-50

-100

-150

-, U.G.R., -
n.7-sc.1:21



  Guide 

User Guide © 2014-2023 105 Marcello Brocato and Ecleti - Roberto Panetta 

To draw the view in black&white check the button 'B&W', and for drawing or not the ruler there is another 
check-box, to rotate the plan view of a certain degree use the 'Rotate view' edit field. 

To examine the other side of the surface it is necessary to select from the 'Settings' tab or through the 
dialogue in the 'Lighting'->'Settings' menu the item 'Other side view' check-box. 

In the same way, for the visualization in finite elements we have to select from the 'Frame mesh' check-
box. 

From the 'File'->'Export' menu it will be possible to save the results, for the visible side of the surface, in a 
file: 

• JPEG (bitmapped) for color visualization; 
• PDF (vectorial) for curves and numeric fields mapping; 
• DXF 2D for curves and numeric fields mapping. 

From the 'Edit'->'Copy' menu the result for the visible side of the surface will be transferred to the 
clipboard. 

According to the selected element, the left side edit field permits to examine and copy all available 
results. Labels conform to the following: 

• ‘H…’ = Horizontal illuminament, ‘V…’ = Vertical illuminament, ‘S’ = semicylindrical illuminament, 
‘Cam’ = Camera direction illuminament, ‘l…’ = luminance, ‘UGR’ = Uniform Glare Ratio, ‘CGI’ = 
Contrast Glare Index, ‘GR’ = Glare Ratio, ‘CRF’ = Contrast Rendering Factor (2), ‘DLF’ = Daylight 
factor, ‘UDI’ = Useful Daylight Illuminance (3), ‘SHF’ = Shadow Factor (4), ‘GRD…’ = Gradient (5); 

• ‘x+’ = value from x axis positive direcion, ‘y+’ = value from y axis positive direction, ‘x-’ = value 
from x axis negative direcion, ‘y-’ = value from y axis negative direction; 

• ‘m’ = minimum, ‘µ’ = average, ‘M’ = maximum value. 

4.9.2.1. Selecting Furniture 

The Application replies with no results. 

4.9.2.2. Selecting a Flat Surface 

The Application presents a projection orthogonal to the plan of the surface. Creating on video a 
rectangular region (click-drag-release mouse operation) it is possible to select those finite elements of the 
surface also partially belonging to the region. For these elements, the Application presents an analysis of 
the result in the status line. Switching back to the standard perspective view if the 'Curve map' button is 
checked the iso-values curves will be plotted in 3d. 

4.9.2.3. Selecting an Object 

The Application presents a central-type projection eventually with unified radius for the object. Creating 
on video rectangular region (click-drag-release mouse operation) it is possible to select those finite 
elements of the surface belonging to the region. For these elements, the Application presents an analysis 
of the result in the status line. 

 
2 Available only if the usere inserted less than 3 observers in the model. 

3 Useful Daylight Illuminance (UDI) is a modification of Daylight Autonomy conceived by Mardaljevic and Nabil in 2005. This metric 
bins hourly time values based upon three illumination ranges, 0-100 lux, 100-2000 lux, and over 2000 lux. It provides full credit 
only to values between 100 lux and 2,000 lux suggesting that horizontal illumination values outside of this range are not useful. 

4 Percentage of shadowed / total surface, useful for evaluating building facade shadowing. 

5 Maximum slope of the illuminament surface sectioned along X and Y direction in the selected point. 
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4.9.3. Command: OTHER SIDE 

Active only in the result analysis mode, it permits 
to show the back-side of the surface. The mark 
“√” in the menu advises that the user look at the 
back-side of the element. 

4.9.4. Command: RESULT SETTINGS  

With Illuminando it is possible to examine results 
in very many ways, available both on video and 
in the bitmapped, numeric or vectorial 
exportation. 

It is possible to obtain information, depending 
from the type of the selected element, on: 

• horizontal illum.: horizontal illuminance in 
lux (for “horizontal” we mean “normal to 
the surface”); 

• emi-cylindrical illum.: Semi-cylindrical 
illuminance (parallel to the surface, direction of the local X-axis direction - only user surfaces); 

• hemispherical illum.: Hemispherical illuminance (parallel to the surface - only road surfaces); 
• vertical X+, Y+, X-, Y- light.: four Vertical illuminance in lux (for “vertical” we mean “parallel to 

the surface, in the direction of the local X-axis and Y-axis, positive and negative sides” - only user 
surfaces) average and uniformity as minimum/average and minimum/maximum ratio; 

• Gradient H (horizontal…), Vx+, Vy+, Vx-, Vy- (vertical…): slope of the illuminament surface 
sectioned along X and Y direction in the selected point  (see note 5 at pag.105); 

• camera N: the illuminament in the camera direction (only user surfaces) average and uniformity 
as minimum/average and minimum/maximum ratio; 

• Luminance: luminance in cd/m2 (only not-user surfaces); 
• Luminance observer 1...6: luminance in cd/m2 or cd/ft2 in the direction of the observer 1, ... (only 

road surfaces); 
• U.G.R.: Unified Glare Ratio (only user surfaces) mapped in 8 directions; 
• G.R.: Glare Ratio (only user surfaces) mapped in 8 directions; 
• C.R.F.: Contrast Rendering Factor (only user surfaces); 
• C.G.I.: Contrast Glare Index (only user surfaces); 
• Daylight Factor: if calculation goes on only for sky radiation (only 'normal' surfaces) average, 

minimum and maximum; 
• UDI: Useful Daylight Illuminance (see note 3 at pag.105 - available only if calculation proceeded 

with holes and/or sky vault option enabled); 
• SHF: Shadow Factor (see note 5 at pag.105 - only not-user surfaces). 

The results viewed on the screen may be copied in the clipboard or exported in all available formats that 
are bitmapped, vectorial or numeric. 

The dialog is divided into three sections: the upper side is relative to the color visualization, the central 
one to iso-value curves and the lower to the numeric fields mapping. 

4.9.4.1. Color Mapping 

By selecting “Color mapping (horizontal)” button the user can examine the horizontal (on the surface) 
lighting. At 8-colors (button “False”), eventually mapping luminances (“Luminance” check-box), it is 
possible to choose the spectrum to plot results among three ones. 
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At real-color visualization (button “True”) for the single finite elements is possible to apply to the view a 
“Filter” to simulate a luminous sensation less or more similar to the human eye sensitivity. 

Luminance may be mapped in a linear (filter “none”), quadratic (filter “2”) or fourth-root (filter “4”) way, 
according to the following scheme: 

 
The following figure shows luminous sensation filters in a day lighted room: 1=none, 2=quadratic, 
3=human eye: 

   
With the value contained in the “Threshold” edit field it is possible to create an “high-pass” filter, to 
emphasize (by a color selectable from the pop-up menu “Color” near this edit field) those finite elements 
that are in a lower lighting condition then the fixed threshold. 

In this mode the chromatic effect in the video scene is “proportional” to the real effect according to an 
input value in the “Saturation” edit field. Lower saturation values make the scene lighter, higher values 
permit a better mapping on higher lighting values. With the “Max” button the Application suggests as 
saturation, the maximum lighting value found in the project. The Saturation field, finally, may be 
considered as the aperture of a camera. 

4.9.4.2. Curve mapping 

Curve mapping may be executed in the modes proposed by the Application, according to the type of the 
selected element (user surface or not) and to the type of calculation (only sky diffuse radiation or other). 
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The “Curve color” pop-up menu permits to choose the color for the curves to plot, while selecting "Colour 
scale" every curve will be plotted following the spectrum colour scale of the paragraph 4.9.4.1. The user 
can choose the first curve (field “Min.”), the last one (field “Max.”) and the number of curves to plot (field 
“Curve num.”), while it is possible to plot curves at “logarithmic intervals” checking the appropriate 
button. The “Auto range” button optimizes the plot from the minimum to the maximum value available in 
the selected element. 

The “Spline” fields permit to choose the type of interpolation for the curves to plot. 

Once cheched the "Curve Map" box for a flat surface, the user will have the actual 2D map plotted also 
in 3D: uncheck the box in the "Result Setting" dialogue to release this option. 

4.9.4.3. Values mapping 

Values mapping may be executed in the modes proposed by the Application, according to the type of the 
selected element (user surface or not) and to the type of calculation (only sky diffuse radiation or other). 

The “Color” pop-up menu permits to choose the color for the values to plot. 

4.9.4.4. Others 

At the end of the dialogue there is the pop-up menu "Luminance" that permits to switch from the standard 
photopic calculation of the luminance to the unified (MOVE modified) one. This take count of the mesopic 
vision due to: 

• the luminance field L (linearly interpolated from scotopic L≤0,25 to photopic L≥3,00 cd·m-2) ; 
• the lamp type, color and power (Scotopic/Photopic lamp parameter). 

The Unified Luminance L is calculated as follow: 

L = ëê
é

ûú
ùXP

683 + 
(1-X)S
1700  · 

683
X+0.402(1-X)  

...where 

• X is the MOVE parameter defined through the next graphic: 

 
• S and P are the Scotopic and Photopic parameters whose ratio is function of the lamp type, color 

and power: this parameter is calculated as the average of all the lamp present in the project. 

Finally, there is a field "Text Height " permits to choose the height of the text in the visualization. 
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4.9.5. Command: CONFIGURATIONS 

With the tool 'Configurations' the application permits to study different solution for lighting one scene with 
artificial sources or combine some calculation to build a new one. 

It is important to remember that configurations have to be compliant one each other, in the sense that the 
only differences between them may be: 

• modifying lighting sources (move, add, delete, reshape, change layer,...) 
• hiding, showing layers 
• changing elements colors 

Calculation not done Calculation done 

  
 

• It will be possible to save the configuration through the '+' button once the calculation will be 
done; 

• the '-' button permits to delete the selected configurations; 
• the '√' button makes the selected configuration the active one, like in the following image: 

 
If the configuration we're going to save is not compliant with the saved ones the application will reply 
deleting the saved configurations: 
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For combining more configurations into a new one the user has to fix the 'weight' of the single 
configuration in the '%' column and then press the 'Build' button: 

 
an alert will inform the user that the actual scene will be not compliant with the configuration to build and 
some results will be eliminated: 

 

4.9.6. Command: LIGHTING POLLUTION 

The application calculates the upward flux (the flux emitted by all lighting sources to the sky vault 
considering obstructions), and will divide this for the total flux (the flux emitted by all lighting sources) to 
obtain the project Upward ratio. The result will be presented in the following panel: 
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5. Tutorials 

5.1. Open area 
This tutorial permits to build a simple open area. 

5.1.1. Building the area 

1. The first step consist in opening from the menu "File" the item "Area Wizard" that will open the 
standard dialog; navigate in the "Luminaires" folder to choose "DEMO.illdolib" catalogue in which 
select the "Projector, HST 1x150W" luminaire (point 1): 

 
2. Then let's choose the layout as "Corner light mast" (point 2) and the area dimension and grid and 

the pole height (point 3);   
3. As basket let's choose a rectangular one and fix its parameters following the upper image (point 

4);   
4. When finished press the "Create Area" button and the Application will build the requested area. 

1 
2 

3 

5 

4 
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5.1.2. Aiming sources  

Select all the source opening with the mouse a rectangle, as the next image propose: 
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Please, notice that the sources are created as symmetric both for X and Y axis. Then select the command 
'Edit'-'Rotate', and in the relative dialogue set the parameters following the next image: 

 
All the sources were tilted of 15°. Now select the top-right source, as the next image propose: 

 
... and select the command 'Edit'-'Reshape' to manually orient this source. At the prompt 'Pick the source 
origin or the axis to modify' pick with the mouse near the arrow head (the pointing vector): if the 
operation succeed, the source pointing will follow the mouse, as the following image shows: 
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Try to click as the previous image propose, then make a similar operation on the top-left source and You'll 
reach the final configuration: 
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5.1.3. Starting calculation 

 Select in the menu "Lighting" the item "Calcul...", erase the content of the "Number of multiple reflections" 
edit field and then pushing the button "Ok"... 

 
 ...the software will compute the direct lighting calculation. To examine the results at this first step, select 
the surface and choose the menu "Lighting"->"Results": 

 
Zooming to a scale of 1/75 (menu "View" "Zoom scale" "1/75"), typing 100 in the "Saturation val." edit 
field and choosing "Color Map" + "Curve Map" + "Autoscale" + Curves "Num."=5, You will see the 
following view: 
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 In which is presented the flat surface n.1 in true color and isolux curves. You can change the show results 
mode in some other way through the drawer settings (see 4.9.4 Command: RESULT SETTINGS)  Opening 
with the mouse a rectangle inside the surface or simply making a click somewhere, the partial result values 
will be presented: opening a rectangle from the top-left corner 1 to the bottom-right one 2 of the projected 
surface, the information on the whole surface will be presented: 

 
In the left drawer will be presented the values relative to the selected zone. 
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5.1.4. Preparing the report  

For this, we have to choose the picture we want to show in the first page (menu "View"->"Save Image for 
Report as 'Cover design'"), in the "Installation of the fixtures" paragraph (menu "View"->"Save Image for 
Report as 'Layout design'") and in the "Result on worktop" paragraph (menu "View"->"Save Image for 
Report as 'Result design'").  

The procedure is simple. To export the 'Result design' picture we have to select for first the surface whose 
results we want to represent and then all the elements we want to project on it: then choose the "Lighting"-
>"Result" menu, and finally select the visualization option we want to view in the report page. Follows an 
example: 

 

 

To save in the 'Result design' picture-slot select the menu command 'View'->'Save Image for Report as 
Result design'. Come back to the 3D general view by selecting "Lighting"->"Result" menu again.  

To export the 'Layout design' we have to select for first the surface we want to use as reference plan and 
then all the elements we want to project on it to create an installation layout. Follows an example in which 
the view is plotted in black+red+white (managing from the left drawer). Then choose the "View"->"Plan 
View" menu and adjust the view by centering and zooming (better in scale) it. 

 

 

To save in the 'Layout design' picture-slot select the menu command 'View'>'Save Image for Report as 
Layout design'. Come back to the 3D general view by selecting "View"->"Plan View" menu again. 

 To export the 'Cover design' simply adjust the last 3D general view to your preferences. In the following 
picture the view is plotted in black+red+white and the 3D-model linking on. 
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To save in the 'Cover design' picture-slot select the menu command 'View'->'Save Image for Report as 
Cover design'. Then select the "File"->"Export" menu and set your preferences. Pressing the "Ok" button 
the software will ask to save the report file: select the "RTF" or "RTFD" format in the pop-menu and choose 
the exportation preferences. Follows an example: 

 



  Tutorials 

User Guide © 2014-2023 119 Marcello Brocato and Ecleti - Roberto Panetta 

Then let's open the saved file to add some picture in: (follow the opened pages). 
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The first operation is to the file in a native format. 

Then, scroll the document to see if each picture is contained in the relative page (it is possible to resize 
them) and to update fields (the table with the Product List at the end of document contains some formulas: 
it is possible to view and modify them with specific commands inside each word processor).  
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Now we can paste into the document some rendered image. Come to Illuminando and, from the 3D 
general view, select the command "View"->"Rendering": you'll se something like this: 

 
Now with the 'Virtual sphere' mouse-method rotate (click-drag procedure), zoom (mouse wheel) and drag 
(right-button + click-drag procedure) the view to make it similar to the one presented in the next figure: 

 
Save the view with the + button down in the drawer. Now, following the next figure, set parameters: 
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Copy the image in the clipboard and go to page 4 of the report. Put the insertion point after the image, 
press Return, type "RENDERING", press Return again, then paste the clipboard content. After resizing the 
pasted image in the report file you will see a new page: 

 
Activate the Result tab and adjust the "Saturation" at the value of 250 lux and check the "False Colors 
rendering" box, to see the following imagine: 
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Copy the image in the clipboard and go to page 5 of the report. Put the insertion point after the image 
pasted before, press Return and paste the clipboard content  (You can also hard-copy the color-scale at 
the bottom of the window and paste it in the report, like in the next figure):      

 
Save the file and this is all! 
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5.2. Rectangular room 
This tutorial permits to build a simple rectangular room and to choose an efficient lighting solution. 

5.2.1. Building the room.  

1. The first step consist in opening from the menu "File" the item "Room Wizard" that will open the 
standard dialog; let's choose the room parameters and the surface color following the scheme at 
point 1: 

 
2. Then navigate in the "Luminaires" folder to choose "DEMO.ildolib" catalogue (point 2) in which 

select the "Recessed 3000K, LED 1x36W" luminaire (point 3). 
3. In the "Lux" edit field everything is ok, press the "Create room" button and the Application will 

build the room to start calculations. 
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Select a wall and assign colour and texture following the next image (scale texture to 0,5): 

 
Accept the dialogue, copy the wall characteristic (Menu ‘Edit’->’Copy’) and select all the other walls 
through the Menu ‘Edit’->’Select special...’: 
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Accept the dialogue and paste texture to the selected element through the Menu ‘Edit’->’Paste special...’ 
(control to check the ‘Textures’ box): 

 
Do the same procedure for one of the roof face, with the following texture and scale: 

 
Accept the dialogue, copy the wall characteristic (Menu ‘Edit’->’Copy’), select all the other roof face and 
paste the texture characteristic with the Menu ‘Edit’->’Paste’. 

Now the room is ready for calculation. 

5.2.2. Starting calculation 

Select in the menu "Lighting" the item "Calcul...", erase the content of the "Number of multiple reflections" 
edit field and then pushing the button "Ok"... 

 
...the software will compute the direct lighting calculation. To examine the results at this first step, select 
the user surface and choose the menu "Lighting"->"Results": 
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Zooming to a scale of 1/20 (menu "View" "Zoom scale" "1/20"), typing 500 in the "Saturation val." edit 
field and choosing "Color Map" + "Curve Map" + "Autoscale", You will see the following view: 

 
In which is presented the flat surface n.8 in true color and isolux curves. You can change the show results 
mode in some other way through the drawer settings (see menu "Lighting"->"Settings..."). 
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Opening with the mouse a rectangle inside the surface or simply making a click somewhere, the partial 
result values will be presented: opening a rectangle from the top-left corner 1 to the bottom-right one 2 of 
the projected surface, the information on the whole surface will be presented: 

 
In the left drawer will be presented the values relative to the selected zone. Then we can go on in multiple 
reflections: choose "Lighting"->"Calcul..." from the menu: 

 
We have the 100% of interreflection to redistribute and we can look for the best value to cut the 
reflections at the first step: choose "Analyze": 
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...and with the mouse bring the horizontal red line near the knee between 40.18 and 60.27: pressing 
"OK" the luminance threshold will be fixed. For now, it is better to do 4 multiple reflection, and put 0.5 as 
the minimum emitted intensity, as presented in the upper dialogue. Pressing "Ok" other 4 reflections will 
be done with this threshold. 

And now, let's examine again the result: select the user surface and select the menu "Lighting" "Results". 
Open a rectangle that include the whole surface and read the results: 

 
We can go on in multiple reflections or stop calculation accepting the results. 

5.2.3. Preparing the report 

For this, we have to choose the picture we want to show in the first page (menu "View"->"Save Image for 
Report as 'Cover design'"), in the "Installation of the fixtures" paragraph (menu "View"->"Save Image for 
Report as 'Layout design'") and in the "Result on worktop" paragraph (menu "View"->"Save Image for 
Report as 'Result design'"). 

The procedure is simple.  
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To export the 'Result design' picture we have to select for first the surface whose results we want to 
represent and then all the elements we want to project on it: then choose the "Lighting"->"Result" menu, 
and finally select the visualization option we want to view in the report page. Follows an example: 

  
To save in the 'Result design' picture-slot select the menu command 'View'->'Save Image for Report as 
Result design'. Come back to the 3D general view by selecting "Lighting"->"Result" menu again.  

To export the 'Layout design' we have to select for first the surface we want to use as reference plan and 
then all the elements we want to project on it to create an installation layout. Follows an example in which 
the view is plotted in black+red+white (managing from the left drawer). Then choose the "View"->"Plan 
View" menu and adjust the view by centering and zooming (better in scale) it. 

  

To save in the 'Layout design' picture-slot select the menu command 'View'>'Save Image for Report as 
Layout design'. Come back to the 3D general view by selecting "View"->"Plan View" menu again. To 
export the 'Cover design' simply adjust the last 3D general view to your preferences. In the following 
picture the view is plotted in black+red+white and the 3D-model linking on.  

To save in the 'Cover design' picture-slot select the menu command 'View'->'Save Image for Report as 
Cover design'. Then select the "File"->"Export" menu and set your preferences. Pressing the "Ok" button 
the software will ask to save the report file: select the "RTF" or "RTFD" format in the pop-menu and choose 
the exportation preferences. Follows an example: 
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Then let's open the saved file to add some picture in: (follow the opened pages). 

 



  Tutorials 

User Guide © 2014-2023 133 Marcello Brocato and Ecleti - Roberto Panetta 
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The first operation is to save the file in a native format.  

Then, scroll the document to see if each picture is contained in the relative page (it is possible to resize 
them) and to update fields (the table with the Product List at the end of document contains some formulas: 
it is possible to view and modify them with specific commands inside each word processor). Now we can 
paste into the document some rendered image. Come to Illuminando and, from the 3D general view, 
select the command "View"->"Rendering". You'll se something like this: 

 
Eventually, turn off the ‘Grid’, put the ‘Ambient light’ at 0% and with the view buttons and the 'Virtual 
sphere' mouse-method rotate (click-drag procedure), zoom (mouse wheel) and drag (right-button + click-
drag procedure) the view until You see something like the following figure: 
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Save the view with the ‘+’ button down in the drawer and give it ‘std’ as name. Activate ‘Map results’ and 
uncheck ‘False color rendering’ option, then You’ll see something like this: 
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Select the front most wall (it will start blinking) and with the contextual menu select ‘Hide this’: 

  
Do the same procedure with the other front most wall and roof: 

 
Now adjust the "Saturation" at the value of 300 lux, copy the image in the clipboard and go to page 4 of 
the report. Put the insertion point after the image, press Return, type "RENDERING", press Return again, 
then paste the clipboard content. After resizing and cropping the pasted image in the report file you will 
see a new page: 
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Come back to Illuminando, check the "False Colors rendering" box, hide the three front most surfaces (like 
before) and You’ll have the following: 

 
Copy the image in the clipboard and go to page 5 of the report. Put the insertion point after the image 
pasted before, press Return and paste the clipboard content (You can also hard-copy the color-scale at 
the bottom of the window and paste it in the report, like in the next figure): 
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Save the file and this is all! 
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5.3. Road 
This tutorial permits to build a road and to choose an efficient lighting solution. 

5.3.1. Building the road with the road tool.  

1. The first step consist in opening from the menu "File" the item "Road Wizard..." that will open the 
road tool, choosing the "ATON.ildolib" catalogue and the fixture n.2 and then set the parameters 
like in the following figure: 

 
2.    Pressing the "Start optimization" button the software will create the model for the selected 

configuration: 
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We can start calculation: choose "Lighting" - "Calcul" and accept the following options: 

 
 Select the road surface and the lines on it with a crossing window selection... 
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...choose "Lighting" - "Result..." and put the view in scale 1:50 accepting the following parameters: 

 
Opening with the mouse a rectangle that contains the whole face (light green one), You'll se the global 
results: 
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You can investigate what's happened in several zones dragging some rectangle inside the surface: the 
drawer will present the results for that zone: 

 
Now we'll export the report. Scroll a little the view to make the light-green selection rectangle disappear 
and choose the menu "View"-"Save image for report as “Result Design” to include this view in the report.  

Return to the main view choosing again "Lighting" - "Results" from the menu, add to the selection set the 
two red luminaires... 
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...and choose "View" - "Plan view" from the menu. You will see the following figure that represent the 
project layout and then choose the menu "View"-"Save image for report as “Layout Design" to include this 
view in the report: 

 
Come back to the main view choosing again "View" - "Plan view" from the menu and force the display in 
black/red/white by choosing "View" - "Black/White" from the menu, and from the drawer turn off the 
"grid visualization" (the icon must be unhighlighted) and turn ON the "3D models linking" (the icon must 
be highlighted). You will see: 
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Choose the menu "View"-"Save image for report as 'Cover Design'"; to include this view in the report. 
Now choose "File" - "Export..." with RTF or RTFD format... 

 
...and accept the previous parameters in the dialogue. 

Press 'Save' and go on. Find the file just now created and open it with a word processor. Follow the 
opened pages: 
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Save the file in a native format and let's add some other results map for the road surface. 
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Select again the surface and the lines... 

 
...and choose "Lighting" - "Results" from the menu. Then set the parameters in the drawer as follows 
(Curve map: Camera 1 Luminance; Autoscale; n.curves: 8): 
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Click somewhere on the view and copy it, than go to the report file at pag.5, place the cursor after the 
image, press 'return' and paste the copied image. The report file will have a page more: 

 
Set the parameters in the drawer as follows (Curve map: Camera 2 Luminance; Autoscale; n.curves: 8): 
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Click somewhere on the view and copy it, than go to the report file at pag.6 (the new added one), place 
the cursor after the image, press 'return' and paste the copied image. The report file will have a page 
more: 

 
Save the file and this is all. 
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5.4. Manage photometries 
This tutorial permits to import a photometric file, to do some manipulations on it and to export a full 
report. 

5.4.1.  Import, correct and save a photometric file.  

1. The first step consist in importing the 'demo.ldt' file from the catalogue pop-menu: 

 
2.       Let's correct the name in 'demo. 36x750mA LED' simply with a double-click on the table row 

to enter the edit mode. 
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3. Now let's rotate the photometry 90° azimuth to make the plan of the maximum emission (in the 
previous image, the plan of the blue curve, C=90°/270°) the main plan (C=0°-180°): from the 
'Operation' pop-menu 'Rotate +90° azimuth'. 

 
4. For coherence we need to rotate also the geometry 90° azimuth, through the 'x<>y' button in the 

fixture box: 

 
5.     Now we have to notice that the total power is equal to the lamp power: 

 
6. This may be or may be not an error, but for now we assume that this is the inconsistence of the 

EULUMDAT file, so let's correct the total power adding a 10% of power due to the ballast 
consumption: type '10%' in the 'Power W or %' edit field in the Fixture box and press return, to let 
the application calculate the real total consumption: 
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⇒ 

 

7. Select an image to link to this photometry by clicking the 'Image Link' button in the fixture box, 
and select the 'recessed60x60led.jpg' one in the folder suggested by the application. The button 
will change in 'Image Unlink' (this button now will be used to discard actual link) and the image 
box will be filled with the selected picture: 

 
8. At this point we can save the fixture in the open catalogue simply clicking the 'Save Fixture' 

button: remember that until now the active catalogue was not updated on disk, so we have to 
select the 'Save catalogue' pop-menu to make permanent the modifications. 

5.4.2. Examine photometry 

1. The user is able to choose the photometry representation through the 'View' pop-menu among the 
polar, Cartesian or table view: 
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2.             Is it also possible to plot a single curve, both the C=0°/C=180° and C=90°/C=270° 
curves or all the C-curves through the 'Plot' pop-menu: let's select 'All curves' from the 'Plot' pop-
menu and 'Polar' from the 'View' pop-menu, and the Photometry box will present the following 
diagram... 

 
3. ...that may be copied in the pasteboard with the 'Copy photometry as PDF/PNG' commands in 

the 'Catalogue' pop-menu: 
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5.4.3.       Export photometry protocol.  

1. It is possible to export in PDF the total report for the selected photometry, through the 'Export 
selected photometries' command in the Catalogue pop-menu: 

 
2.     Then select 'PDF report' as Format and the parameters following the next image: 
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3. The saved report will contain one page with the photometry summary, 12 pages presenting the I-
table and one page with the planar representation of the photometric solid: 
•  photometry summary: 

 

•     I-table: 



  Tutorials 

User Guide © 2014-2023 159 Marcello Brocato and Ecleti - Roberto Panetta 

 

  ...follows 11 pages 

• ...   planar representation of the photometric solid: 
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That's all! 

5.5. Manage spectra data 
This tutorial permits to open, examine and save in the 'Lamps.txt' file an XML file formatted following IES 
TM-27-14 IES Standard Format for the Electronic Transfer of Spectral Data or CSV format. 
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5.5.1. Open the data.  

1. The first step consist in selecting (from the menu "File" or from the button) the "Open" command: 

 
2. navigate in the Brotens library folder to find and open the file "demo spectra.spdx"; the window 

will present the data: 

 
3. go to the 'CIE diagrams / comparison' tab and examine the color position in the CIE diagrams: 
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4. In the "Library" tab is still present the "Lamps.txt" file with the list of the lamps; 

 
5. Now we want to save the spectra data as a bulb in the "Lamps.txt" Library: come back to the 

"Spectra" tab and fill the "Information for saving" fields as follow: 

 
6.    Select (from the menu "File" or from the button) the "Save spectra" and the spectra data will be 

saved as a bulb in the "Lamps.txt" Library: come back to the "Library" tab to see the result: 
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That's all! 
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5.6. Using polyline-sources 
This tutorial permits to understand the use of polyline-sources to simulate a strip-led source. 

5.6.1. Creating and saving a 'specific' photometry 

Open the Sources Library Manager, load the Demo.ildolib library and duplicate the 'Recessed 3000K 
LED 1x36W' model: 

 

Rename it 'Strip Led 15W', change parameters following the next figure and save the catalogue: 
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5.6.2. Buliding the model 

Create a squared face with the following characteristics: 

 
Create a polyline-arc with the following parameters and place it at (0,0,0): 

 
Now select the polyline-arc and move it at (0,0,500): 
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Select the polyline-arc, choose 'Reshape' from the 'Edit' menu and ⌘(command)+click on the center vertex 
to delete it (first image), pres 'Esc' key and the scene will be presented following the second image: 

 
Select the polyline-arc again, choose 'Info' from the 'Edit' menu and change the type in 'Source' selecting 
the 'Strip Led 15W' model for it; the scene will be update according to the second image: 

 
Select the polyline-arc again, choose 'Local' from the 'Coordinate' menu (first image) and then with the 
⌥(option) key pressed select 'Rotate X' from the 'Coordinate' menu (second image); in this way we 
changed the orientation of the emitted flux according the curvature of the strip-led source: 
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Choose 'Global' from the 'Coordinate' menu and we're ready to start calculation. 

5.6.3. Calculation and results 

Choose 'Calc' from the 'Lighting' menu and set parameters following the next dialogue: 

 
Select the face, choose 'Results' from the 'Lighting' menu and set the parameters following the next image: 
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5.6.4. Change the shape of the polyline-source 

Choose 'Results' again from the 'Lighting' menu, select the polyline-source and choose 'Info' from the 'Edit' 
menu and set its parameters according to the next left image, accept to discard results and the scene will 
change according the next right image: 

  
Select the polyline-arc, choose 'Reshape' from the 'Edit' menu and ⌘(command)+click on the center vertex 
to delete it (first image), pres 'Esc' key and the scene will be presented following the second image: 

  
Select the polyline-arc again, choose 'Info' from the 'Edit' menu and change the type in 'Source' selecting 
the 'Strip Led 15W' model for it; the scene will be update according to the second image: 
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Select the polyline-arc again, choose 'Local' from the 'Coordinate' menu (first image) and then with the 
⌥(option) key pressed select 'Rotate X' from the 'Coordinate' menu (second image); in this way we 
changed the orientation of the emitted flux according the curvature of the strip-led source: 

  
Choose 'Global' from the 'Coordinate' menu and 'Calc' from the 'Lighting' menu setting parameters 
following the next dialogue: 

 
Select the face, choose 'Results' from the 'Lighting' menu and set the parameters following the next image: 
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That's all! 
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5.7. Appendix A: Analysis results 
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5.8. Appendix B: Luminaire protocol 

 

LIGHTING SOURCE PROTOCOL

Model: 325+316, miniTensoDOMO QUADRETT.arg. + miniTensoCIELI DIFF.
Catalog: CINI&NILS.ildolib

CIE classification: Semi-Direct
Total power: 120.00W
Dimensions: 20.2 x 22.5 x 10.0 cm
Luminous volume: 20.2 x 22.5 x 0.0 cm
Efficency: 43 %

Zonal fluxes [lm]:
- 0/30: 116.10 (11.11 %)
- 0/40: 213.45 (20.42 %)
- 0/60: 481.48 (46.06 %)
- 0/90: 838.16 (80.19 %)
- 90/120: 145.42 (13.91 %)
- 90/130: 186.95 (17.89 %)
- 90/150: 205.22 (19.63 %)
- 90/180: 207.08 (19.81 %)
- 0/180: 1045.24 (100.00 %)

Installed lamp/s:
- n.: 1
- type: Halogen
- name: linear
- socket: R7s
- power: 120.00 W
- flux: 2450 lm
- color temp.: 3000 K

Side shades:
- depth: 0.0 cm
- angle C=0: 0.0 cm
- angle C=90: 0.0 cm
- angle C=180: 0.0 cm
- angle C=270: 0.0 cm

Grid:
- xy dimensions: 0.0 x 0.0 cm
- depth: 0.0 cm

- 1 - Illuminando
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...follows all other fields 

LIGHTING SOURCE PROTOCOL

     |                                               C                                               |
gamma|      0|     10|     20|     30|     40|     50|     60|     70|     80|     90|    100|    110|
   0d|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|   54.2|
   1d|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|   54.1|
   2d|   54.1|   54.1|   54.1|   54.1|   54.0|   54.0|   54.0|   54.0|   54.0|   54.0|   54.0|   54.0|
   3d|   54.1|   54.1|   54.1|   54.0|   54.0|   54.0|   54.0|   53.9|   53.9|   54.0|   53.9|   53.9|
   4d|   54.1|   54.1|   54.0|   54.0|   53.9|   53.9|   53.9|   53.9|   53.9|   53.9|   53.9|   53.9|
   5d|   54.1|   54.1|   54.0|   53.9|   53.8|   53.8|   53.8|   53.8|   53.8|   53.8|   53.8|   53.8|
   6d|   54.2|   54.2|   54.1|   54.0|   53.8|   53.8|   53.7|   53.7|   53.7|   53.7|   53.7|   53.7|
   7d|   54.4|   54.3|   54.2|   54.0|   53.8|   53.8|   53.7|   53.6|   53.6|   53.6|   53.6|   53.6|
   8d|   54.6|   54.4|   54.3|   54.0|   53.8|   53.8|   53.6|   53.5|   53.5|   53.5|   53.5|   53.5|
   9d|   54.7|   54.5|   54.4|   54.1|   53.7|   53.7|   53.5|   53.4|   53.3|   53.3|   53.3|   53.4|
  10d|   54.9|   54.7|   54.5|   54.1|   53.7|   53.7|   53.5|   53.2|   53.2|   53.2|   53.2|   53.2|
  11d|   55.1|   54.9|   54.7|   54.2|   53.8|   53.8|   53.5|   53.1|   53.1|   53.1|   53.1|   53.1|
  12d|   55.4|   55.1|   54.8|   54.4|   53.9|   53.9|   53.5|   53.0|   53.0|   53.0|   53.0|   53.0|
  13d|   55.6|   55.3|   55.0|   54.5|   54.0|   54.0|   53.4|   52.9|   52.9|   52.8|   52.9|   52.9|
  14d|   55.9|   55.5|   55.2|   54.6|   54.0|   54.0|   53.4|   52.8|   52.8|   52.7|   52.8|   52.8|
  15d|   56.1|   55.7|   55.4|   54.8|   54.1|   54.1|   53.4|   52.7|   52.6|   52.6|   52.6|   52.7|
  16d|   56.9|   56.4|   55.8|   55.0|   54.2|   54.2|   53.4|   52.6|   52.5|   52.4|   52.5|   52.6|
  17d|   57.7|   57.0|   56.3|   55.3|   54.3|   54.3|   53.4|   52.6|   52.4|   52.3|   52.4|   52.6|
  18d|   58.4|   57.6|   56.8|   55.6|   54.4|   54.4|   53.4|   52.5|   52.3|   52.2|   52.3|   52.5|
  19d|   59.2|   58.2|   57.2|   55.8|   54.5|   54.5|   53.4|   52.4|   52.2|   52.1|   52.2|   52.4|
  20d|   60.0|   58.8|   57.7|   56.1|   54.5|   54.5|   53.4|   52.3|   52.1|   51.9|   52.1|   52.3|
  21d|   61.9|   60.5|   59.1|   57.0|   54.8|   54.8|   53.6|   52.3|   52.1|   51.9|   52.1|   52.3|
  22d|   63.7|   62.1|   60.5|   57.8|   55.2|   55.2|   53.7|   52.2|   52.0|   51.8|   52.0|   52.2|
  23d|   65.6|   63.8|   61.9|   58.7|   55.5|   55.5|   53.8|   52.2|   52.0|   51.7|   52.0|   52.2|
  24d|   67.5|   65.4|   63.4|   59.6|   55.8|   55.8|   54.0|   52.2|   51.9|   51.6|   51.9|   52.2|
  25d|   69.3|   67.1|   64.8|   60.4|   56.1|   56.1|   54.1|   52.1|   51.8|   51.5|   51.8|   52.1|
  26d|   70.6|   68.3|   66.0|   61.4|   56.9|   56.9|   54.5|   52.2|   51.8|   51.5|   51.8|   52.2|
  27d|   71.8|   69.5|   67.2|   62.4|   57.7|   57.7|   55.0|   52.2|   51.9|   51.5|   51.9|   52.2|
  28d|   73.0|   70.7|   68.4|   63.4|   58.5|   58.5|   55.4|   52.3|   51.9|   51.4|   51.9|   52.3|
  29d|   74.2|   71.9|   69.6|   64.4|   59.3|   59.3|   55.8|   52.3|   51.9|   51.4|   51.9|   52.3|
  30d|   75.4|   73.1|   70.8|   65.4|   60.1|   60.1|   56.2|   52.4|   51.9|   51.4|   51.9|   52.4|
  31d|   76.0|   73.6|   71.2|   66.0|   60.7|   60.7|   56.6|   52.4|   51.7|   51.1|   51.7|   52.4|
  32d|   76.6|   74.1|   71.7|   66.5|   61.4|   61.4|   56.9|   52.4|   51.6|   50.8|   51.6|   52.4|
  33d|   77.2|   74.7|   72.1|   67.1|   62.0|   62.0|   57.2|   52.5|   51.5|   50.5|   51.5|   52.5|
  34d|   77.8|   75.2|   72.6|   67.6|   62.6|   62.6|   57.6|   52.5|   51.4|   50.3|   51.4|   52.5|
  35d|   78.4|   75.7|   73.0|   68.2|   63.3|   63.3|   57.9|   52.5|   51.2|   50.0|   51.2|   52.5|
  36d|   78.9|   76.1|   73.4|   68.4|   63.4|   63.4|   57.9|   52.3|   50.9|   49.4|   50.9|   52.3|
  37d|   79.4|   76.6|   73.8|   68.6|   63.5|   63.5|   57.8|   52.2|   50.5|   48.8|   50.5|   52.2|
  38d|   79.8|   77.0|   74.1|   68.9|   63.6|   63.6|   57.8|   52.0|   50.1|   48.2|   50.1|   52.0|
  39d|   80.3|   77.4|   74.5|   69.1|   63.7|   63.7|   57.8|   51.9|   49.7|   47.5|   49.7|   51.9|
  40d|   80.8|   77.8|   74.8|   69.3|   63.8|   63.8|   57.7|   51.7|   49.3|   46.9|   49.3|   51.7|
  41d|   81.6|   78.5|   75.4|   69.6|   63.9|   63.9|   57.6|   51.3|   48.6|   46.0|   48.6|   51.3|
  42d|   82.4|   79.2|   76.0|   70.0|   64.0|   64.0|   57.4|   50.9|   48.0|   45.0|   48.0|   50.9|
  43d|   83.3|   79.9|   76.5|   70.3|   64.1|   64.1|   57.3|   50.5|   47.3|   44.1|   47.3|   50.5|
  44d|   84.1|   80.6|   77.1|   70.6|   64.2|   64.2|   57.1|   50.1|   46.6|   43.2|   46.6|   50.1|
  45d|   84.9|   81.3|   77.6|   70.9|   64.2|   64.2|   57.0|   49.7|   46.0|   42.2|   46.0|   49.7|
  46d|   86.6|   82.6|   78.5|   71.4|   64.3|   64.3|   56.7|   49.1|   45.2|   41.2|   45.2|   49.1|
  47d|   88.3|   83.9|   79.4|   71.9|   64.4|   64.4|   56.5|   48.5|   44.3|   40.2|   44.3|   48.5|
  48d|   90.1|   85.2|   80.4|   72.4|   64.5|   64.5|   56.2|   47.9|   43.5|   39.2|   43.5|   47.9|
  49d|   91.8|   86.5|   81.3|   72.9|   64.6|   64.6|   56.0|   47.3|   42.7|   38.2|   42.7|   47.3|
  50d|   93.5|   87.9|   82.2|   73.4|   64.7|   64.7|   55.7|   46.7|   41.9|   37.2|   41.9|   46.7|
  51d|   96.2|   89.8|   83.4|   74.2|   65.0|   65.0|   55.5|   46.0|   41.2|   36.3|   41.2|   46.0|

- 2 - Illuminando
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5.9. Appendix C: IES-NA data interchange format 
of: (Ian Ashdown, P. Eng. Research & Development Manager - Ledalite Architectural Products 

Incorporated 9087A - 198th Street - Langley, B.C. - Canada V1M 3B1 - Tel. (604) 888-6811 
- Fax. (604) 888-0566 - e mail: iashdown@ledalite.com - URL: http://www.ledalite.com ... 

Synopsis: The IESNA LM-63 photometric data file is an ASCII text file commonly used by North 
American lighting fixture manufacturers to distribute photometric information about their 
products. ... 

The Standard File Format IES ... is an ACII text file. There are three revisions, based on LM-63-1986, LM-
63-1991, and LM-63-1995. 

5.9.1. IES LM-63-1986 

The file format specification for the LM-63-1986 variant is: 

Id Description 

01 {label line 1} 

02 {label line 2} 

03 ... 

04 {label line n} 

05 TILT={file-spec} or {INCLUDE} or {NONE} 

06 {lamp-to-luminaire geometry} 

07 {# of pairs of angles and multiplying factors} 

08 {angles} 

09 {multiplying factors} 

10 {# of lamps} {lumens per lamp} {candela multiplier} {# of vertical angles} {# of horizontal angles} 
{photometric type} {units type} {width} {length} {height} 

11 {ballast factor} {ballast-lamp photometric factor} {input watts} 

12 {vertical angles} 

13 {horizontal angles} 

14 {candela values for all vertical angles at first horizontal angle} 

15 {candela values for all vertical angles at second horizontal angle} 

16 ... 

17 {candela values for all vertical angles at nth horizontal angle} 

A detailed description of each line is presented in the following sections. 

5.9.2. IES LM-63-1991 

The file format specification for the LM-63-1991 variant is: 

Id Description 

00 IESNA91 

01 {Keyword [TEST]} 

02 {Keyword [MANUFAC]} 

03 ... 
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04 {Keyword n} 

05 TILT={file-spec} or {INCLUDE} or {NONE} 

06 {lamp-to-luminaire geometry} 

07 {# of pairs of angles and multiplying factors} 

08 {angles} 

09 {multiplying factors} 

10 vertical angles} {# of horizontal angles} {photometric type} {units type} {width} {length} {height} 

11 {ballast factor} {ballast-lamp photometric factor} {input watts} 

12 {vertical angles} 

13 {horizontal angles} 

14 {candela values for all vertical angles at first horizontal angle} 

15 {candela values for all vertical angles at second horizontal angle} 

16 ... 

17 {candela values for all vertical angles at nth horizontal angle} 

The changes between LM-63-1986 and LM-63-1991 are: 

• Identifier line 00 ("IESNA91") was added to distinguish the file from LM-63-1986 photometric 
data files. 

• The free-form label lines (identifiers 01 through 04) were replaced with lines that begin with user-
defined keywords. 

A detailed description of each line is presented in the following sections. 

5.9.3. IES LM-63-1995 

The file format specification for the LM-63-1995 variant is: 

Id Description 

00 IESNA:LM-63-1995 

01 {Keyword 1} 

02 {Keyword 2} 

03 ... 

04 {Keyword n} 

05 TILT={file-spec} or {INCLUDE} or {NONE} 

06 {lamp-to-luminaire geometry} 

07 {# of pairs of angles and multiplying factors} 

08 {angles} 

09 {multiplying factors} 

10 {# of lamps} {lumens per lamp} {candela multiplier} {# of vertical angles} {# of horizontal angles} 
{photometric type} {units type} {width} {length} {height} 

11 {ballast factor} {future use} {input watts} 

12 {vertical angles} 
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13 {horizontal angles} 

14 {candela values for all vertical angles at first horizontal angle} 

15 {candela values for all vertical angles at second horizontal angle} 

16 .. . 

17 {candela values for all vertical angles at nth horizontal angle} 

The changes between LM-63-1991 and LM-63-1995 are: 

• Identifier line 00 was changed to "IESNA:LM-63-1995") to distinguish the file from LM-63-1986 
and LM-63-1991 photometric data files and other (future) IESNA standard file formats. 

• The number of predefined keywords was expanded and new features (such as support for near-
field photometric data) introduced via the keyword mechanism. 

• The {ballast-lamp photometric factor} was changed to {future use}. 

A detailed description of each line is presented in the following sections. 

5.9.4. IES Standard File Format - Detailed Description 

All lines shall be terminated with a {CR}{LF} pair. (This is the text file convention for MS-DOS programming 
environments). 

An "identifier line" as presented in Section 2, "IES Standard File Format - Specification," may be consist of 
one or more ASCII text lines in the photometric data file. Multiple lines are typically present when the 
space needed to represent the values in the identifier line exceeds the allowable line length. 

The maximum length of any label / keyword line (including the {CR}{LF} terminating pair) is 82 characters. 
The maximum length of any other line (including the {CR}{LF} terminating pair) is 132 characters. 

5.9.4.1. File Format Identifier (Identifier Line 00) 

IES LM-63-1991 and LM-63-1995 photometric data files begin with a unique file format identifier line, 
namely "IESNA91" or "IESNA:LM-63-1995". IES LM-63-1986 does not have a file format identifier line. 

5.9.4.2. Label Lines / Keywords (Identifier Lines 01 Through 04) 

Label lines contain descriptive text about the luminaire, the lamp(s) used, and other descriptive comments. 
Keywords, which were introduced in LM-63-1991, require that each label line begins with a defined IES 
keyword in square brackets. For example: 

[TEST]  ABC1234 ABC Laboratories 

The keywords [TEST] and [MANUFAC] are required in LM-63-1991, but not in LM-63-1995. (Label lines 
are optional in LM-63-1986 and LM-63-1995.) The following keywords are a suggested minimum for LM-
63-1995: 

[TEST]  Test report number and laboratory 

[MANUFAC] Luminaire manufacturer 

[LUMCAT] Luminaire catalog number 

[LUMINAIRE] Luminaire description 

[LAMPCAT] Lamp catalog number 

[LAMP] Lamp description 

LM-63-1995 presents a list of predefined keywords that identify test-related data, luminaire product 
information, luminaire characteristics, and miscellaneous information. User-defined keywords are also 
permitted. 
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Details regarding the syntax of user-defined keywords are presented in IES LM-63-1995. The 
accompanying IES Standard File parser reads and stores, but does not interpret, keyword lines. 

5.9.4.3. TILT= (Identifier Line 05) 

The lamp output may vary as a function of the luminaire tilt angle. If so, then the photometric data file may 
provide photometric data multipliers for various tilt angles. The "TILT=" line uniquely delimits the end of 
label / keyword lines in the photometric data file. 

There are three variants of this line: 

• "TILT=NONE": The lamp output (presumably) does not vary as a function of the luminaire If 
TILT=NONE is present, the identifier lines 06 {lamp-to-luminaire geometry}, 07 {# of pairs of 
angles and multiplying factors} 08 {angles}, 09 {multiplying factors} are not present in the 
photometric data file. 

• "TILT=INCLUDE": The lamp output varies as a function of the luminaire tilt angle. If TILT=INCLUDE 
is present, the identifier lines 06 {lamp-to-luminaire geometry}, 07 {# of pairs of angles and 
multiplying factors} 08 {angles}, 09 {multiplying factors} are present in the photometric data file. 

• "TILT={filename}": The lamp output varies as a function of the luminaire tilt angle. If 
TILT={filename} is present (where "filename" is the name of a valid TILT photometric data file), the 
identifier lines 06 {lamp-to-luminaire geometry}, 07 {# of pairs of angles and multiplying factors} 
08 {angles}, 09 {multiplying factors} are present in the identified and separate TILT photometric 
data file. 

5.9.4.4. Lamp-to-Luminaire Geometry (Identifier Line 06) 

This integer value indicates the orientation of the lamp within the luminaire as follows: 

1. Lamp base is either vertical base up or vertical base down when the luminaire is aimed straight 
down. 

2. Lamp is horizontal and remains horizontal when the luminaire is aimed straight down or rotated 
about the zero-degree horizontal plane. 

3. Lamp is horizontal when the luminaire is pointed straight down, but does not remains horizontal 
when the luminaire is rotated about the zero-degree horizontal plane. 

The lamp-to-luminaire geometry line is absent if TILT=NONE. 

5.9.4.5. Number of Pairs of TILT Angles and Multiplying Factors (Identifier Line 07) 

This integer value indicates the total number of lamp tilt angles and their corresponding candela 
multiplying factors. It is absent if TILT=NONE. 

5.9.4.6. TILT Angles (Identifier Line 08) 

This line enumerates the (floating point) lamp tilt angles. It is absent if TILT=NONE. 

5.9.4.7. TILT Multiplying Factors (Identifier Line 09) 

This line enumerates the (floating point) candela multiplying factors for the corresponding lamp tilt angles. 
It is absent if TILT=NONE. 

5.9.4.8. Number of Lamps (Identifier Line 10) 

This integer value indicates the total number of lamps in the luminaire. 

5.9.4.9. Lumens Per Lamp (Identifier Line 10) 

This floating point value indicates the rated lumens per lamp on which the photometric test was based. 
(This value is obtained from the lamp manufacturer's published technical data for the lamp, and does not 
represent the actual lumens emitted by the test lamp). 
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If the luminaire has two or more lamps with different rated lumens per lamp, this value represents the 
average lumens per lamp for the luminaire. In the (very rare) cases of absolute photometry, this value is -
1. 

5.9.4.10. Candela Multiplier (Identifier Line 10) 

This floating point value indicates a multiplying factor that is to be applied to all candela values in the 
photometric data file (identifier lines 14 through 17). 

5.9.4.11. Number of Vertical Angles (Identifier Line 10) 

This integer value indicates the total number of vertical angles in the photometric data (identifier lines 14 
through 17). 

5.9.4.12. Number of Horizontal Angles (Identifier Line 10) 

This integer value indicates the total number of horizontal angles in the photometric data (identifier lines 
14 through 17). 

5.9.4.13. Photometric Type (Identifier Line 10) 

This integer value indicates the type of photometric web used for the photometric measurements as 
follows: 

1. Type C photometry 
2. Type B photometry 
3. Type A photometry 

Luminaries are photometered by locating the luminaire at the center of an imaginary sphere and 
measuring the light intensity (candela) values at grid points (the "photometric web') on the sphere's 
surface. The orientation of the luminary’s axes relative to that of the sphere determines the photometric 
type. 

Type C photometry is normally used for architectural and roadway luminaries. The polar axis of the 
photometric web coincides with the vertical axis of the luminaire, and the 0-180 degree photometric plane 
coincides with the luminary’s major axis (length). 

Type B photometry is normally used for adjustable outdoor area and sports lighting luminaries. The polar 
axis of the luminaire coincides with the minor axis (width) of the luminaire, and the 0-180 degree 
photometric plane coincides with the luminary’s vertical axis. 

Type A photometry is normally used for automotive headlights and signal lights. The polar axis of the 
luminaire coincides with the major axis (length) of the luminaire, and the 0-180 degree photometric plane 
coincides with the luminary’s vertical axis. 

It is important to note that these photometric types are *not* clearly defined in IES LM-63. All three 
versions refer the reader to the IES Lighting Handbook for descriptions of Type A and Type B photometry, 
and to CIE 27-1973 ("Photometry of Luminaries for Street Lighting") and CIE 43-1979 ("Photometry of 
Floodlights") for a description of Type C photometry. It then says that "Type C is the form in common use 
in the United States (although it was formerly referred to as Type A)." 

This is in contrast to CIE Publication 102-1993, "Recommended File format for Electronic Transfer of 
Luminaire Photometric Data," which clearly and unambiguously defines three types of photometry: A 
(alpha), B (beta), and C (gamma). The diagrams in CIE 102-1993 leave no doubt as to how their 
photometric webs are oriented with respect to the luminaire. Unfortunately, the IES LM-63 Type A 
photometry is equivalent to the CIE 102-1993 Type C photometry, and the IES LM-63 Type C photometry 
is equivalent to the CIE 102-1993 Type A photometry. 
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5.9.4.14. Units Type (Identifier Line 10) 

This integer value indicates the units used for the dimensions of the luminous opening in the luminaire as 
follows: 

1. Feet 
2. Meters 

5.9.4.15. Luminous Opening Dimensions (Identifier Line 10) 

While the term "luminous opening" is somewhat ambiguous for many architectural luminaries and other 
light sources, it is useful in calculating average luminaire luminances and modeling the luminaries as 
homogeneous area light sources. 

5.9.4.15.1. Luminaire Width 

This floating point value indicates the distance across the luminous opening of the luminaire as measured 
along the 90-270 degree photometric plane. 

5.9.4.15.2. Luminaire Length 

This floating point value indicates the distance across the luminous opening of the luminaire as measured 
along the 0-180 degree photometric plane. 

5.9.4.15.3. Luminaire Height 

This floating point value indicates the average height of the luminous opening of the luminaire as 
measured along the vertical axis. 

5.9.4.15.4. Nonrectangular Luminous Openings 

The luminous opening is normally considered to be rectangular. However, other predefined shapes can 
be modeled by specifying one or more of the above dimensions as zero or negative floating point 
numbers as follows:  

Width Length Height Description 

 0 0 0 Point  

w l h rectangular (default) 

 -d 0 0 Circular (where d = diameter of circle)  

-d 0 -d Sphere (where d = diameter of circle)  

-d 0 h Vertical cylinder (d = diameter of cylinder) 

 0 l -d Horizontal cylinder oriented along lum.length  

w 0 -d Horizontal cylinder oriented along lum.width  

-w l h Ellipse oriented along luminaire length 

 w -l h Ellipse oriented along luminaire width 

 -w l -h Ellipsoid oriented along luminaire length  

w -l -h Ellipsoid oriented along luminaire width  

See 5.9.3 IES LM-63-1995 IES for detailed descriptions and diagrams. 
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5.9.4.16. Ballast Factor (Identifier Line 11) 

This floating point value indicates the ratio of the lamp lumens when operated on a commercially-
available ballast, to the rated lamp lumens as measured by the lamp manufacturer using a standard 
(reference) ballast. 

All candela values in the photometric data file (identifier lines 14 through 17) must be multiplied by the 
ballast factor before the candela values are used in an application program. 

5.9.4.17. Ballast-Lamp Photometric Factor / Future Use (Identifier Line 11) 

In LM-63-1986 and LM-63-1991, this floating point value indicates the ratio of the lamp lumen output 
using the given ballast and lamp type used to generate a photometric report, to the lumen output of the 
same luminaire with the ballast and lamp type used for photometric testing. 

In LM-63-1995, it was recognized that most lighting manufacturers incorporate the ballast-lamp 
photometric factor in the preceding ballast factor and set the ballast-lamp photometric factor to unity. 

Consequently, the ballast-lamp photometric factor was designated as being for future use and the value 
set to unity to be compatible with previous releases of LM-63. 

All candela values in the photometric data file (identifier lines 14 through 17) must be multiplied by the 
ballast-lamp photometric factor before the candela values are used in an application program. 

5.9.4.18. Input Watts (Identifier Line 11) 

This floating point value indicates the total power (measured in watts) consumed by the luminaire, as 
measured during the photometric test (the input watts value is *not* adjusted by the ballast factor or 
ballast-lamp photometric factor, even though the power consumption of a luminaire may change if the 
measured candela values are modified). 

5.9.4.19. Vertical Angles (Identifier Line 12) 

This line enumerates the (floating point) vertical angles. For Type C photometry, the first vertical angle will 
be either 0 or 90 degrees, and the last vertical angle will be either 90 or 180 degrees. 

For Type A or B photometry, the first vertical angle will be either -90 or 0 degrees, and the last vertical 
angle will be 90 degrees. 

5.9.4.20. Horizontal Angles (Identifier Line 13) 

This line enumerates the (floating point) horizontal angles. 

For Type C photometry, the first value is (almost) always 0 degrees, and the last value is one of the 
following: 

0° There is only one horizontal angle, implying that the luminaire is laterally symmetric in all 
photometric planes; 

90° The luminaire is assumed to be symmetric in each quadrant; 

180° The luminaire is assumed to be bilaterally symmetric about the 0-180 degree photometric plane; 

360° The luminaire is assumed to exhibit no lateral symmetry (6). 

A luminaire that is bilaterally symmetric about the 90-270 degree photometric plane will have a first value 
of 90 degrees and a last value of 270 degrees. 

For Type A or B photometry where the luminaire is laterally symmetric about a vertical reference plane, 
the first horizontal angle will be 0 degrees, and the last horizontal angle will be 90 degrees. 

 
6 This is an error in the draft IES LM-63-1995 standard, because the 360-degree plane is coincident with the 0-degree plane. It 

should read "greater than 180 degrees and less than 360 degrees" 
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For Type A or B photometry where the luminaire is not laterally symmetric about a vertical reference 
plane, the first horizontal angle will be -90 degrees, and the last horizontal angle will be 90 degrees. 

5.9.4.21. Candela Values (Identifier Lines 14 Through 17) 

These lines enumerate the (floating point) candela values. There is one line for each corresponding 
horizontal angle, and one candela value for each corresponding vertical angle. 

5.9.5. IES Standard File Example 

The following is an example of an IES LM-63-1995 photometric data file: 

 
The following is an example of an IES LM-63-1995 photometric data file: 
 
IESNA:LM-63-1995 
[TEST] ABC1234 ABC Laboratories 
[MANUFAC] Aardvark Lighting Inc. 
[LUMCAT] SKYVIEW 123-XYZ-abs-400 
[LUMINAIRE] Wide beam flood to be used without tilt 
[LAMPCAT] MH-400-CLEAR 
[LAMP] Metal Halide 400 watt 
[BALLASTCAT] Global 16G6031-17R 
[BALLAST] 400W 277V MH 
[MAINTCAT] 4 
[OTHER] This luminaire is useful as an indirect flood 
[MORE] and to reduce light pollution in down light 
[MORE] applications. 
[SEARCH] POLLUTION SPORTS INDIRECT 
[BLOCK] 
[LUMCAT] TENNISVIEW 123-XYZ-abc-400 
[LUMINAIRE] Wide beam flood for indirect applications. 
[ENDBLOCK] 
TILT=INCLUDE 
1 
13 
0 15 30 45 60 75 90 105 120 135 150 165 180 
1.0 .95 .94 .90 .88 .87 .98 .87 .88 .90 .94 .95 1.0 
1 50000 1 5 3 1 1 .5 .6 0 
1.0 1.0 495 
0 22.5 45 67.5 90 
0 45 90 
10000 50000 25000 10000 5000 
10000 35000 16000 8000 3000 
10000 20000 10000 5000 1000 
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5.10. Appendix D: EULUMDAT data interchange format 
of: Zumtobel Licht's COPHOS Development Team, http://www.cophos.co.at  

Synopsis: Proposal for a data format for exchange of luminaire data (interior, exterior, and/or road 
lighting luminaries) under the operating systems ms-dos 2.xx/3.xx under condition of 
unequivocal coordination between luminaire and data set...  

NOTE: Each of the following fields is an ASCII string that is terminated with an MS-DOS 'CR+LF' pair. 

N. Description N.character 
1 Company ident./data bank/version/format identif. max. 78 

2 

Ityp = Type indicator: 
1 ... point source with symmetry about the vert.axis 
2 ... linear luminaire 
3 ... point source with any other symmetry (only linear luminaries, Ityp = 2, are being 
subdivided in longitudinal and transverse directions) 

1 

3 

Isym = Symmetry indicator: 
0 ... no symmetry 
1 ... symmetry about the vertical axis 
2 ... symmetry to plane C0-C180 
3 ... symmetry to plane C90-C270 
4 ... symmetry to plane C0-C180 and C90-C270 

1 

4 Mc = Number of C-planes between 0° e 360° (usually 24 for interior, 36 for road 
luminaries) 2 

5 Dc = Distance between C-planes (Dc = 0 for non-equidistantly available C-planes) 5 
6 Ng = Number of luminous intensities in each C-plane (usually 19 or 37) 2 

7 Dg = Distance between luminous intensities per C-plane (Dg = 0 for non-equidistantly 
available luminous intensities in C-planes) 5 

8 Measurement report number max. 78 
9 Luminaire name max. 78 
10 Luminaire number max. 78 
11 File name 8 
12 Date/user max. 78 
13 Length/diameter of luminaire (mm) 4 
14 Width of luminaire b (mm) (b = 0 for circular luminaire) 4 
15 Height of luminaire (mm) 4 
16 Length/diameter of luminous area (mm) 4 
17 b1 = Width of luminous area (mm) (b1 = 0 for circular luminous area of luminaire) 4 
18 Height of luminous area C0-plane (mm) 4 
19 Height of luminous area C90-plane (mm) 4 
20 Height of luminous area C180-plane (mm) 4 
21 Height of luminous area C270-plane (mm) 4 
22 DFF = Downward flux fraction (%) 4 
23 LORL = Light output ratio luminaire (%) 4 
24 Conversion factor for luminous intensities (depending on measurement) 6 
25 Tilt of luminaire during measurement (road lighting luminaries) 6 

26 n = Number of standard sets of lamps (optional, extendable on company-specific 
basis) 4 

26a Number of lamps n * 4 
26b Type of lamps n * 24 
26c Total luminous flux of lamps (lm) n * 12 
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26d Color appearance / color temperature of lamps n * 16 
26e Color rendering group / color rendering index n * 6 
26f Wattage including ballast (W) n * 8 

27 DR = Direct ratios for room indices 0.6÷5 (for determination of luminaire numbers 
according to utilization factor method) 10 * 7 

28 Angles C (beginning with 0°) Mc * 6 
29 Angles G (beginning with 0°) Ng * 6 

30 

Luminous intensity distribution (cd/klm) 
(Mc2-Mc1+1)*Ng*6 with: 
Isym = 0: Mc1 = 1 Mc2 = Mc 
Isym = 1: Mc1 = 1 Mc2 = 1 
Isym = 2: Mc1 = 1 Mc2 = Mc/2+1 
Isym = 3: Mc1 = 3*Mc/4+1 Mc2 = Mc1+Mc/2 
Isym = 4: Mc1 = 1 Mc2 = Mc/4+1 
 

 

5.10.1. EULUMDAT Standard File Example 

 The following is an example of an EULUMDAT photometric data file (the file is splitted into 4 columns for 
clarity): 

LED 
2 
1 
24 
15 
31 
3.0 
LED00004 
Ipotesi 2S MH-T 
-- 
LED00004 
21.12.90/Lue 
300 
180 
160 
244 
146 
0 
0 
0 
0 
100 
51.9 
1.0 
0.0 
1 
1 
CDM-T 70W/83 
6200.0 
- 
- 
0.0 
0.83282 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

0.86265 
0.88517 
0.91294 
0.92490 
0.93917 
0.94937 
0.95872 
0.96163 
0.96680 
0 
15 
30 
45 
60 
75 
90 
105 
120 
135 
150 
165 
180 
195 
210 
225 
240 
255 
270 
285 
300 
315 
330 
345 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

0.0 
3.0 
6.0 
9.0 
12.0 
15.0 
18.0 
21.0 
24.0 
27.0 
30.0 
33.0 
36.0 
39.0 
42.0 
45.0 
48.0 
51.0 
54.0 
57.0 
60.0 
63.0 
66.0 
69.0 
72.0 
75.0 
78.0 
81.0 
84.0 
87.0 
90.0 
7296.4 
6035.9 

3432.3 
1260.4 
478.3 
254.6 
174.4 
137.3 
117.1 
103.7 
87.5 
74.5 
67.3 
61.6 
55.6 
38.2 
12.4 
4.2 
2.2 
2.0 
1.9 
1.9 
0.3 
0.0 
0.0 
0.0 
0.0 
0.2 
0.0 
0.0 
0.0 
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5.11. Appendix D: "Wires.txt" file structure 
In this file, a text tab-formatted one, wire information are saved following the next scheme: 
PRODUCT PICTURE MAX.LENGTH TOLERANCE EURO 

Exp 
EURO 
Ita 

EURO 
Ger 

EURO 
Fra 

EURO 
Spa 

EURO 
Ned 

EURO 
Aus 

EURO 
Bel 

FS 
Swz 

DKK 
Den 

EURO 
Gre 

GBP 
Uk 

AAA AAA.jpg 12,5 12,5 68 68 68 68 68 68 68 68 68 68 68 68 

BBB BBB.jpg 20 3 107 107 107 107 107 107 107 107 107 107 107 107 

The "MAX LENGTH" column describe the lenght of the cable-reel, while the "TOLERANCE" column inform 
about swarf or rounding in cable cutting. Next columns has to be filled with the reel prize in several 
currencies. 


